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Unit Overview
In this unit, you will learn how to:

• Create conditional build tags in the Project Manager

• Apply conditional build tags to text and graphics in a topic

• Apply conditional build tags at the topic level

• Use conditional build tag expressions to include and exclude 
content from the output you generate

What Is Conditional Content?
Conditional content is content that is specific to a particular output 
format, audience, product version, or deliverable. 

For example, if you need to produce two versions of your online Help 
system—one for a “Lite” version of your application and the other for 
a “Pro” version—you can flag topics, text, and images that are specific 
to one or the other version. Then, you can generate both versions of 
your Help system from the same Help project files. 

Similarly, if you plan to produce both online Help and printed docu-
ments from your RoboHelp project, you can flag the elements that are 
specific to one output format or the other. 

Note The RoboHelp online Help system refers to conditional 
content as “conditional text.” This terminology, while commonly 
used in the industry, is not truly accurate. In addition to text, you 
can also flag images, tables, and other elements as conditional. 

What Are Conditional Build Tags?
To create conditional content in RoboHelp, you use conditional build 
tags and conditional build tag expressions. Conditional build tags are 
the names you assign to the various conditions you need to manage. 
When you create a conditional build tag, you assign it a name and a 
color. 

For example, you might create two conditional build tags: Help (blue) 
and Print (red). Then, you can apply the Help conditional build tag to 
the content you only want to include in your Help system and apply 
the Print conditional build tag to the content you only want to include 
in printed output. While you’re working in RoboHelp, content tagged 
Help is displayed with a blue background pattern, and content tagged 
Print is displayed with a red background.
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Each new RoboHelp project has two pre-defined 
conditional build tags: Online and Print. RoboHelp 
lists all the conditional build tags you define in a 
project in the Conditional Build Tags folder in the Project Manager. 

What Are Conditional Build Tag Expressions?
You can apply conditional build tags to entire topics or to text and 
other elements within topics. After applying conditional build tags in a 
project, you use conditional build tag expressions to determine what 
RoboHelp includes and excludes from any particular build of your 
Help system. You can define basic or advanced conditional build tag 
expressions. 

Basic conditional build tag expressions let you exclude conditions 
from your output. For example, if you are using Print and Help condi-
tional build tags, you can use a basic conditional build tag expression 
to omit the Print condition from your HTML Help system.

In RoboHelp, conditional build tags are additive. This means that you 
can apply multiple conditional build tags to the same content, and 
then use Boolean operators when you construct conditional build tag 
expressions. 

Advanced conditional build tag expressions let you use Boolean 
operators—AND, OR, and NOT—to handle more complex situations. 
For example, if you are creating online Help and printed documenta-
tion for both “Lite” and “Pro” versions of a product, you might use 
four conditional build tags:

• Print

• Help

• Lite

• Pro

To create the online Help for the Lite version of the product, you 
would use the following advanced conditional build tag expression:

NOT Print AND NOT Pro 

To create a review copy containing all content for both online Help 
and print for the Pro version of the product, you would use the follow-
ing advanced conditional build tag expression:

NOT Lite

RoboHelp provides a dialog box you can use to construct advanced 
conditional build tag expressions. You do not need to type the syntax 
directly. 
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RoboHelp Components in this Unit
This unit introduces the following RoboHelp components:

• Topic Properties Dialog Box, Advanced Tab

• Define Conditional Build Tag Expression Dialog Box

Topic Properties Dialog Box, Advanced Tab
You use the Advanced Tab in the Topic Properties dialog box to apply a 
conditional build tag to an entire topic. By applying a conditional 
build tag to a topic, you ensure that the topic is excluded from your 
TOC, browse sequences, index, and full-text search results. 

Figure 23.1 Topic Properties Dialog Box, Advanced Tab

Define Conditional Build Tag Expression Dialog Box
You use this dialog box to construct conditional build tags that control 
which content is included and excluded from the output you generate. 

Figure 23.2 Define Conditional Build Tag Expression Dialog Box
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Lab 23.1 Use Conditional Build Tags within a Topic

1. In RoboHelp, open your Solitaire Help project.

2. In the Project Manager, expand the Conditional Build Tags folder.

RoboHelp lists the two pre-defined conditional build tags: Online 
and Print. 

3. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.

4. In the second paragraph, select Help file.

5. Right-click the selected text, and then choose Apply Conditional 
Build Tag→Online from the right-click menu. 

The text now appears with a colored background pattern.

6. Click just after the letter s in the word This.

7. Press the space bar, and then type User Guide. 

8. Select User Guide, and then apply the Print conditional build 
tag to the selected text.

The text appears with a colored background pattern.

9. Open the “Options Dialog Box” topic.

10. Right-click the graphic, and then choose Apply Conditional 
Build Tag→Print from the right-click menu.

11. Repeat Step 10 to apply the Print conditional build tag to the 
graphic in the “Select Card Back Dialog Box” topic.

12. In the Project Manager, right-click the Print conditional build tag, 
and then choose Properties from the right-click menu.

RoboHelp displays the Conditional Build Tag Properties dialog box: 

This dialog box lists the topics in which the Print conditional 
build tag has been applied. In the Level column, <Content> 
means that Print has been applied to content within the list top-
ics. 

13. Click OK or Cancel to dismiss the dialog box. 
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Lab 23.2 Apply Conditional Build Tags at the Topic Level

1. Create a new topic in the Procedures folder and name it 
Installation Instructions. 

2. In the “Installation Instructions” topic, type the following topic 
text: 

To install Solitaire, insert the CD and follow 
the instructions that appear on the screen.

3. Add the “Installation Instructions” topic to the TOC right after 
the “Welcome to Solitaire” topic.

4. In the Project Manager or the Topics List, right-click the “Installa-
tion Instructions” topic, and then choose Properties from the 
right-click menu.

5. In the Topic Properties, dialog box, click the Advanced tab.

6. Under Topic-level Tags, select Print, as shown in the following 
illustration: 

7. Click OK.

8. In the Project Manager, right-click the Print build tag, and then 
choose Properties from the right-click menu. 

RoboHelp displays the Conditional Build Tag Properties dialog box: 

In the Level column, <Topic> means that Print has been applied 
to the entire topic. 

9. Click OK or Cancel to dismiss the dialog box. 
Unit 23 Creating Conditional Content Page 178 Lab 23.2 Apply Conditional Build Tags at the Topic Level



D
O

 N
O

T D
U

P
LIC

A
TE – C

o
p

yrig
h

t ©
 1

9
9

8
-2

0
0

3
 D

avid
 A

. K
n

o
p

f, In
c. – D

O
 N

O
T D

U
P

LIC
A

TE 
Lab 23.3 Generate Using a Conditional Build Tag Expression

1. Click View Primary Layout  to generate and view your Help 
system.

2. Inspect the “Welcome to Solitaire” topic.

Both “User Guide” and “Help File” appear in the topic text.

3. Inspect the “Options Dialog Box” and “Select Card Back Dialog 
Box” topics.

Both graphics are displayed.

4. Inspect the TOC.

The “Installation Instructions” page is included in the TOC.

5. Close the Help system.

6. In the Project Manager, expand the Single Source Layouts folder.

7. Right-click the Microsoft HTML Help layout, and then choose 
Properties from the right-click menu.

8. In the HTML Help Options dialog box, click the Define button 
under Conditional Build Tag Expressions.

RoboHelp displays the Define Conditional Build Tag Expression 
dialog box.

9. In the Available tags list, double-click Print to move it to the 
Exclude from output list.

10. Click OK, and then click Save.

11. Generate your Help system, and inspect the TOC, and the 
“Welcome to Solitaire,” “Options Dialog Box,” and “Select Card 
Back Dialog Box” topics.

The “Installation Instructions” topic does not appear in the TOC, 
and “User Guide” does not appear in the “Welcome to Solitaire” 
topic. The graphics do not appear in the “Options Dialog Box” and 
“Select Card Back Dialog Box” topics. 
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Unit Summary
• Conditional content is content that is specific to a particular 

output format, audience, product, or deliverable. 

• Conditional build tags are the names you assign to the various 
conditions you need to manage. 

• After creating conditional build tags, you can apply them to entire 
topics or to text and other elements within topics. 

• After applying conditional build tags, you use conditional build 
tag expressions to determine what RoboHelp includes and 
excludes from any particular build of your Help system. 

• You create conditional build tags in the Project Manager. Robo-
Help lists the conditional build tags you have created in the 
Conditional Build Tags folder.

• To apply conditional build tags to text or other content, select the 
content in the WYSIWYG Editor, right-click the selected content, 
and choose a build tag from the Apply Conditional Build Tag 
submenu. 

• To apply a conditional build tag to an entire topic, use the 
Advanced tab in the Topic Properties dialog box.

• To generate a conditional build of your Help system, right-click 
the layout in the Single Source Layouts folder, and then choose 
Properties from the right-click menu. Define a conditional build 
tag expression in the Options dialog box that appears.
Unit 23 Creating Conditional Content Page 180 Unit Summary
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	Unit 1 Course Introduction
	Audience and Prerequisites
	This course is intended for new users of RoboHelp HTML X3 who plan to use RoboHelp to produce online Help in one of the following two formats:
	. Microsoft HTML Help (.chm)


	Course Objectives
	In this course, you will learn how to use RoboHelp HTML X3 to:

	Course Structure
	Each unit in the course covers a specific subject area related to RoboHelp’s features and functionality. Each unit includes:
	. A Unit Overview that describes what you will learn in the unit


	About the Hands-on Labs
	During the course of the hands-on labs, you will build an actual Help system using RoboHelp. Initially, you will create the Help...

	Course Materials
	The materials for this course include this guide and a course diskette that includes all the sample files you will need as you work through the many hands-on exercises included in the course. No other materials are required.
	Software Used in the Course
	If the course you are attending is open to the public, the following software is installed on the classroom computers:
	. Microsoft Windows 2000 Professional


	Course Diskette
	Included in the course materials is a diskette containing files you will need to complete the hands-on exercises. The course diskette contains a copy of the Solitaire application and an assortment of files you will use to complete the hands-on labs.


	Daily Agenda
	This is a 3-day hands-on training course. The agenda is as follows.
	Day 1
	. Unit 1, “Course Introduction”

	Day 2
	. Unit 9, “Editing and Deleting”

	Day 3


	About the Instructor
	David Knopf is president and founder of Knopf Online, a San Francisco-based firm that provides development, training, and consul...
	Typographic Conventions
	This Student Handbook uses the following typographic conventions:
	. Buttons, drop-down lists, and other dialog box controls are printed in bold, like this:
	Unit 2 The User’s Perspective



	Unit Overview
	In this unit, you will learn:
	. What are the various online Help formats?



	Online Help Formats
	In the early 1990’s, there was essentially one popular online Help format for the Windows platform: Windows Help, usually called “WinHelp.” Since then, many additional Help formats have been introduced. Widely used Help formats now include:
	. Microsoft WinHelp
	- WebHelp (eHelp)
	- JavaHelp (Sun Microsystems)


	What Is HTML Help?
	HTML Help is a compiled, compressed format for delivering online Help for users of 32-bit Windows operating systems (Windows 95 or later). HTML Help is a proprietary format developed by Microsoft and was first released in 1997.

	The HTML Help Viewer
	Figure 2.1 Tri-pane Window in HTML Help Viewer
	Figure 2.2 HTML Help Viewer (Navigation Pane Hidden)

	WebHelp Displayed in a Browser
	WebHelp displays Help topics in a web browser and divides the browser window into the same three regions used in the HTML Help Tri-pane Window, as shown in the following illustration:
	Figure 2.3 WebHelp Displayed in Internet Explorer


	How Users Access Help
	There are many ways for users to access online Help:
	. Within an application, users can:
	- Choose a command from the Help menu
	- Run an HTML Help file directly from Windows Explorer

	. Over the web, users can:
	- Access HTML Help using Internet Explorer




	Components of a Help Topic
	All Help topics include a topic title and some text. Many Help topics also include some combination of the following elements:
	. Hyperlinks
	Figure 2.4 Components of a Typical Procedure Topic


	Types of Help Topics
	Although most users probably could not name them, there are a number of distinct types of online Help topic, including:
	. Overview topics: Describe the main concept(s) for a particular “section” in a Help system.


	Navigating in HTML Help
	Users navigate in an HTML Help system using the following techniques:
	. Using the navigation pane in the tri-pane window (Contents, Index, Search, Favorites)


	What Users Really Do
	. Most users know only the basics about how to use online Help.


	Unit Summary
	. There are many different online Help formats.
	Unit 3 Introduction to RoboHelp

	Unit Overview
	In this unit, you will learn:
	. What is RoboHelp?



	What Is RoboHelp?
	RoboHelp is the industry’s best-selling Help authoring tool, or HAT. It is an end-user application designed principally for authors who need to create:
	. Online Help systems for 32-bit Windows in either WinHelp or HTML Help format, or
	. RoboHelp for Word extends Microsoft Word to enable content authors to use Word to create online Help systems. RoboHelp for Wor...
	. RoboHelp Office combines RoboHelp for Word, RoboHelp HTML, and a collection of utilities useful to Help authors producing any ...

	What Can You Create with RoboHelp?
	Using RoboHelp, you can create:
	. Application Help and standalone information systems in Microsoft HTML Help format for 32-bit Windows



	RoboHelp Strengths and Weaknesses
	Like any software application, RoboHelp has its strengths and weaknesses.
	Strengths
	RoboHelp’s strengths include:
	. RoboHelp is an easy-to-use application with a point-and-click user interface, much of which will seem immediately familiar to people used to working with Microsoft Word.


	Weaknesses
	RoboHelp’s weaknesses include:
	. RoboHelp is a costly, proprietary application that requires every user to have an individual license and whose proprietary file formats can make it difficult to migrate to another environment should authoring requirements change.

	The RoboHelp User Interface
	The RoboHelp user interface includes a large number of components you use to create, maintain, and manage your Help projects.
	Figure 3.1 The RoboHelp User Interface


	Understanding Help Systems and Help Projects
	A Help system is a file or set of files that is delivered to end users and run on their machines to enable them to view information produced by a Help author.
	. Help topics comprising mostly:
	- Text
	- Table of contents



	How to Create a Help System
	It’s obviously not quite as simple as the following list makes it seem, but here, in broad brush strokes, are the main steps involved in creating a Help system:
	1. Choose an output format.
	2. Choose an appropriate authoring tool.
	3. Create a Help project.
	4. Create Help topics.
	5. Add navigation tools, including a TOC and index and perhaps also including a Glossary tab, browse sequences, Related Topics buttons, and the like.
	6. Generate the Help system.
	7. Test the Help system and revise as necessary.
	8. Deliver the Help system to users.


	About HTML Help
	HTML Help is a proprietary, Microsoft Help format designed to run on 32-bit Windows (i.e., Windows 95 or later). HTML Help syste...
	Figure 3.2 The HTML Help User Interface




	About WebHelp
	WebHelp is a proprietary eHelp Help format designed to enable authors to publish content that can be viewed in a variety of web ...
	Figure 3.3 The WebHelp User Interface


	Unit Summary
	. RoboHelp is a Help Authoring Tool (HAT) with which you can produce online Help in five popular online Help formats, as well as printed documents in Microsoft Word format.
	Unit 4 Creating Help Projects

	Unit Overview
	In this unit, you will learn how to:
	. Set up Windows Explorer when using RoboHelp



	What Is a Help Project?
	A Help project is a set of source files you create in RoboHelp, together with files you may create in other software applications, that contains all the content to be used in your Help system.
	RoboHelp Components in this Unit
	This unit introduces the New Project Wizard, which you use to create a new RoboHelp project.
	Figure 4.1 The New Project Wizard


	Lab 4.1 Set Up Windows Explorer
	By default, Windows Explorer hides many important system files and does not display file extensions for common file types. These two settings can make it more difficult to work with RoboHelp.
	1. In Windows Explorer, choose ToolsÆFolder Options.
	2. On the View tab, select Show hidden files and folders and clear Hide file extensions for known file types.
	3. Click OK.


	Lab 4.2 Create a Directory for Your Course Work
	During this course, you will create a large number of files. Before we get started, create a new directory to store your course work.
	1. In Windows Explorer, create a new, top-level directory on your C: drive.
	2. Name the directory HTMLHELP.




	Lab 4.3 Create a New Help Project
	1. On the Windows desktop, choose StartÆProgramsÆRoboHelp OfficeÆRoboHelp HTML.
	2. In the RoboHelp HTML dialog box, select Create a new Project, and then click OK.
	3. If HTML Help is not pre-selected, select it, as shown in the following illustration:
	4. Click OK.
	5. In the New Project Wizard dialog box, do the following:
	6. In RoboHelp, choose ToolsÆOptions.
	7. On the General tab in the Options dialog box, verify that Use underscores in file names and Auto-compile outdated files are both selected. Clear the Show Tip of the Day at startup option.
	8. Click OK.
	9. In Windows Explorer, navigate to the project directory, C:\HTMLHELP\solitaire, and inspect its contents.
	Table 4.1 Initial Project FIles


	Unit Summary
	. Working with RoboHelp projects is easier if you set up Windows Explorer to show all files and to show file extensions even for known file types.
	Unit 5 Creating Help Topics

	Unit Overview
	In this unit, you will learn how to:
	. Create Help topics from scratch



	What Is a Help Topic?
	A Help topic is a single page in a Help system, roughly analogous to a single section or sub-section in a chapter of a book. Whe...
	. Topic Title: Welcome to Solitaire
	. Topic titles are displayed in the Search and Favorites tabs.


	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. The WYSIWYG Editor

	The WYSIWYG Editor
	The WYSIWYG Editor is a point-and-click editor that you use to create and edit Help topics and topic templates. While you edit topics, the WYSIWYG Editor automatically generates the necessary HTML code in the background.
	Figure 5.1 The WYSIWYG Editor


	The TOC Composer
	The TOC Composer is a point-and-click tool you use to build and edit the table of contents in a Help project.
	Figure 5.2 The TOC Composer


	The Topics List
	The Topics List presents an alternate view that you can use to organize, sort, and manage Help topics. You can use the Topics Li...
	Figure 5.3 The Topics List




	Lab 5.1 Create Help Topics
	1. In the “Welcome to Solitaire” topic, replace the placeholder text with the following two paragraphs of text:
	2. On the toolbar, click Create a New Topic .
	3. In the New Topic dialog box, type Game Menu in the Topic Title box, and then click OK.
	4. In the new topic, replace:
	5. Repeat Steps 2-4 to create a topic titled “Scoring Information” accepting the default file name, Scoring_Information.htm. Enter the following topic text:
	6. Create another topic, assigning “Solitaire Window” as the title and accepting the default file name. Type the following topic text:
	7. Select the last three lines of text in the “Solitaire Window” topic.
	8. On the toolbar, click Create a Bulleted List .
	9. Add a blank line at the end of the topic, making sure the blank line does not have a bullet.

	10. Click the Save All toolbar button to save your work.

	Lab 5.2 Create a TOC Book and Add Pages for Existing Topics
	1. Click the TOC tab in the lower left corner of the RoboHelp window.
	2. In the TOC Composer toolbar, click New TOC Book .
	3. In the New TOC Book dialog box, type About Solitaire in the Book Title box, and then click OK.
	4. Click the Topics tab in the lower right corner of the RoboHelp window.
	5. Drag the four topics you have created from the Topics List and drop them into the “About Solitaire” book.
	6. In the TOC Composer, drag and drop to adjust the order of topics until your TOC looks like this:
	Lab 5.3 Generate Your Help System and View the Results
	1. Click the Generate Primary Layout toolbar button.
	2. Click View Result to view your compiled HTML Help project.
	3. Review your results so far.
	4. Close the HTML Help Viewer.


	Lab 5.4 Create Topics and TOC Pages Simultaneously
	1. If the TOC Composer is not visible, click the TOC tab in the lower left.
	2. In the TOC Composer toolbar, click New TOC Book to create a new book in the TOC.
	3. In the Book Title box, type Playing the Game, and then click OK.
	4. If necessary, reposition the book so that it follows the existing “About Solitaire” book.
	5. If it is not already selected, click the “Playing the Game” book to select it.
	6. Using the Create a New Topic toolbar button as you did in Lab 5.1, create five new topics for the Solitaire Help project, using the topic titles shown in the following list and accepting the default file names:
	7. Click the Save All toolbar button to save your work.
	8. Generate your Help system and check the results.

	Lab 5.5 Create Topics by Importing a Word Document
	1. Insert the course diskette in a floppy drive.
	2. Open the Terms.doc file in Microsoft Word and inspect its contents.
	3. Close Microsoft Word.
	4. In RoboHelp, click the Project tab in the lower left.
	5. Choose FileÆImportÆWord Document.
	6. In the Open dialog box, double-click Terms.doc on the course diskette.
	7. Click OK to import the Word document.
	Unit Summary
	. You use the WYSIWYG Editor to create and edit topic text, as well as insert graphics, hyperlinks, and other topic elements. The WYSIWYG Editor is designed as much as possible to look and work like Microsoft Word.
	Unit 6 Using the Project Manager

	Unit Overview
	In this unit, you will learn how to:
	. Use the Project Manager to create folders in which you can organize your project files



	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. The Project Manager

	The Project Manager
	The Project Manager is a point-and-click tool for accessing, organizing, and managing the various files and other components tha...
	Figure 6.1 The Project Manager


	The Reports Window
	RoboHelp includes a report generator that can produce a variety of different reports about your Help project. For example, you c...
	Figure 6.2 The Reports Window




	Lab 6.1 Create Folders and Organize Topic Files
	Create Folders for Topic Files
	1. If the Project Manager is not visible, click the Project tab in the lower left.
	2. In the Project Manager, expand the HTML Files (Topics) folder, and then click to select it.
	3. Choose FileÆNewÆFolder.
	4. Type Procedures, and then press Enter.
	5. Repeat Steps 2-4 to create another folder. Type Glossary as the folder name.
	6. Try to click and then Ctrl-click to select several topics in the HTML Files (Topics) folder.

	Drag Topics from the Topics List into Folders
	7. Click the Topics tab in the lower right.
	8. In the Topics List, hold down the Ctrl key while you click each procedure topic; then, drag the selected procedure topics into the Procedures folder.
	9. Use the same procedure to move all the Glossary topics into the Glossary folder.
	See File Names or Topic Titles in the Project Manager
	10. Choose ViewÆBy File Name.
	11. Choose ViewÆBy Topic Title.

	Lab 6.2 Change Topic Properties and Generate a Report
	1. In the Project Manager, right-click the “Welcome to Solitaire” topic, and then choose Properties from the right-click menu.
	2. In the Topic Properties dialog box, click the Status tab, and then type the following text in the Comment box:
	3. Click OK.
	4. Choose ToolsÆReportsÆTopic Properties.
	5. Click the Options button.
	6. Under Topic Status, select Comment, and then click OK.
	7. Scroll to the bottom of the report, and notice that the comment you entered is listed in the entry for the “Welcome to Solitaire” topic.
	8. Click the Close button to close the report.

	Lab 6.3 Change Properties for a Group of Topics All At Once
	1. Click the Project tab in the lower left.
	2. Click the Topics tab in the lower right.
	3. From the drop-down list at the top of the Topics List, choose the Glossary folder.
	4. Select all topic files in the Glossary folder.
	5. Right-click the selected topics, and then choose Properties from the right-click menu.
	6. In the Topic Properties dialog box, click the Status tab, choose Ready for Review from the Status list, and then click OK.
	7. Choose ToolsÆReportsÆProject Status.
	8. Review the report, and then click the Close button to close it.



	Unit Summary
	. You use the Project Manager to access, organize, and manage the topic files, graphics files, and other elements in a Help project.
	Unit 7 Creating Hyperlinks

	Unit Overview
	In this unit, you will learn how to:
	. Create hyperlinks to existing topics (three techniques)



	What Is a Hyperlink?
	A hyperlink is a bit of text or a graphic that a user can click to go from the current location to another location. Every hyper...
	. When a user clicks a standard hyperlink, the HTML Help Viewer (or web browser) typically replaces the currently displayed topic with the target topic.

	RoboHelp Components in this Unit
	This unit introduces the Hyperlink dialog box, which you use to create hyperlinks in a Help topic.
	Figure 7.1 The Hyperlink Dialog Box




	Lab 7.1 Create Hyperlinks to Existing Topics
	Create Hyperlinks Using the Hyperlink Dialog Box
	1. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	2. Select the text start a brand new game.
	3. To insert a hyperlink, do one of the following:
	4. In the Hyperlink dialog box, choose the Procedures folder from the drop-down list labeled Select destination (file or URL), and then select “Starting a Brand New Game” from the list of topics, as shown in the following illustration:
	5. Click OK.

	Drag and Drop Hyperlinks from the Project Manager
	6. In the WYSIWYG Editor, select the text set game options.
	7. In the Project Manager, click the “Setting Solitaire Options” topic, and drag and drop it over the selected text in the WYSIWYG Editor.
	Drag and Drop Hyperlinks from the TOC Composer
	8. In the WYSIWYG Editor, select the text keep score.
	9. In the TOC Composer, click the “Keeping Score” page, and drag and drop it over the selected text in the WYSIWYG Editor.

	Check Your Work
	10. Generate your Help system and check the results.

	Lab 7.2 Create Hyperlinks and Target Topics Simultaneously
	1. In the “Welcome to Solitaire” topic, type the following text right before the word “and”:
	2. Select the text play the game.
	3. On the toolbar, click Insert Hyperlink .
	4. In the Hyperlink dialog box, click the New Topic button.
	5. In the New Topic dialog box, type Playing the Game in the Topic Title box, and then click OK.
	6. In the Hyperlink dialog box, click OK.
	7. In the “Welcome to Solitaire” topic, click at the end of the topic text (after the “keep score” hyperlink).
	8. Type the following text:
	9. Select the text rules of Solitaire.
	10. Insert a hyperlink from the selected text to a new topic. Name the new topic The Rules.
	11. Open the topic, “The Rules,” in the WYSIWYG Editor.
	12. Start Microsoft Word, and open the Rules.doc file from your course diskette.
	13. In Microsoft Word, select all the text in the Rules.doc file, and then choose EditÆCopy or press Ctrl+C.
	14. Switch back to RoboHelp, and select the text, “Type topic text here.”
	15. Choose EditÆPaste or press Ctrl+V.
	16. Select the text you pasted into the topic.
	17. On the toolbar, click Create a Bulleted List .

	18. Add a blank line after the bulleted list.
	19. Open the “Playing the Game” topic in the WYSIWYG Editor.
	20. Switch back to Microsoft Word, and then open the Playgame.doc file from your course diskette.
	21. In Microsoft Word, select all of the text in the Playgame.doc file, and then choose EditÆCopy or press Ctrl+C.
	22. Close Microsoft Word.
	23. Switch back to RoboHelp, and then select the text, “Type topic text here.”
	24. Choose EditÆPaste or press Ctrl+V.
	25. Generate your Help system and check the results.




	Lab 7.3 Create Popup Hyperlinks
	1. Open the “Scoring Information” topic in the WYSIWYG Editor.
	2. Select the word Standard.
	Create a Popup Using the Hyperlink Dialog Box
	3. To insert a popup hyperlink, do one of the following:
	4. In the Hyperlink dialog box, do the following:
	a. In the Hyperlink Options area, select Display in auto-sizing popup
	b. In the Select destination (file or URL) list, choose the Glossary folder.
	c. Select “Standard Scoring” in the list of topics.
	d. Click OK when the dialog box looks like this:

	Create a Popup Hyperlink from the Toolbar
	5. Select the word Vegas.
	6. On the toolbar, click Insert Popup .
	7. In the Popup dialog box, select the “Vegas Scoring” topic, and then click OK.

	Create Additional Popups Using Either Method
	8. In the topics titled “Solitaire Window” and “The Rules,” create popup hyperlinks for deck stack, suit stacks, and row stacks, choosing the appropriate topic in the Glossary folder as the target for each popup.
	9. Generate your Help system and check your work.

	Lab 7.4 Create a Master Glossary Topic
	1. Click the Project tab in the lower left.
	2. On the toolbar, click Create a New Topic .
	3. In the New Topic dialog box, type Solitaire Glossary in the Topic Title box, and then click OK.
	4. In the new “Solitaire Glossary” topic, select and delete the text:
	5. Click in the blank line beneath the topic title.
	6. Open the Hyperlink dialog box in one of the ways you learned in Step 3 in Lab 7.1.
	7. In the Hyperlink dialog box, do the following:
	a. Select the Display in auto-sizing popup option.
	b. In the Select destination (file or URL) list, select the “Deck Stack” topic in the Glossary folder, and then click OK.
	c. Press Enter to start a new line.
	8. Repeat Step 7 to create hyperlinks to the other glossary topics:
	9. Generate your Help system and check your work.


	Lab 7.5 Organize New Topic Files
	1. Click the Project tab in the lower left.
	2. In the Project Manager, create a new folder and name it Overviews.
	3. Using the Project Manager and the Topics List, move the following topics into the Overviews folder:
	4. Move the “Playing the Game” topic into the Procedures folder.
	5. Move the “Solitaire Glossary” topic into the Glossary folder.


	Lab 7.6 Create a Hyperlink to a Web Site
	1. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	2. Type the following text as a new paragraph below at the end of the topic:
	3. Select the text, visit the Solitaire.com web site.
	4. Open the Hyperlink dialog box.
	5. From the Link to drop-down list, choose Web Address.
	6. Complete the URL as shown:
	7. Click OK when the dialog box looks like this:
	8. Generate the Help system and check your work.
	9. Close the HTML Help Viewer.
	10. In the “Welcome to Solitaire” topic, double-click the “visit the Solitiare.com web site” hyperlink.
	11. In the Hyperlink Options area, choose New Window from the Display in frame drop-down list, and then click OK.
	12. Generate the Help system and try the “visit the Solitaire.com web site” hyperlink.

	Lab 7.7 Update the TOC to Include New Topics
	1. Click the TOC tab in the lower left.
	2. Expand both books in the TOC
	3. Click the Topics tab in the lower right.
	4. Choose All Folders from the drop-down list at the top of the Topics List.
	5. In the Topics List, click the topic, “The Rules,” and drag it into the “About Solitaire” book in the TOC Composer.
	6. In the Topics List, click the “Playing the Game” topic and drag it into the “Playing the Game” book in the TOC Composer.
	7. Create a new book after the “Playing the Game” book by doing one of the following:
	8. In the New TOC Book dialog box:
	a. Type Solitaire Glossary in the Book Title box.
	b. Select the Book with Link option.
	c. Choose “Solitaire Glossary” from the Existing Topics list.
	d. Click OK when the dialog box looks like this:
	9. From the Topics List, drag the glossary topics into the “Solitaire Glossary” book.
	10. Generate your Help system and check your work.
	11. Close the HTML Help Viewer.
	12. In the TOC Composer, right-click the “Playing the Game” book, and then choose Properties from the right-click menu.
	13. Use the TOC Book Properties dialog box to link the “Playing the Game” book to the “Playing the Game” topic.
	14. Repeat Steps 12-13 to link the “About Solitaire” book to the “Welcome to Solitaire” topic.
	15. Generate your Help system and check your work.

	Unit Summary
	. A hyperlink is a bit of text or a graphic that a user can click to go from the current location to another location. Every hyperlink has a target.
	- standard hyperlinks

	. You can create hyperlinks in several ways:
	- Using the Hyperlink dialog box

	. You can create a hyperlink and its target topic simultaneously.
	Unit 8 Testing and Debugging

	Unit Overview
	In this unit, you will learn how to:
	. Find and resolve Help project errors



	How Do You Test a Help Project?
	Testing a Help project is an interactive process. You generate the Help system, review it, identify any problems, correct them, and then repeat the process until all errors and other problems are resolved.
	. The Topic Properties report


	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. The Output View

	The Output View
	The Output View appears at the bottom of the RoboHelp window when you generate your Help system. It displays status messages when you generate your Help system.
	Figure 8.1 The Output View


	The Resolve Broken Links Dialog Box
	The Resolve Broken Links dialog box helps you to identify and resolve broken links in a Help project.
	Figure 8.2 The Resolve Broken Links Dialog Box




	Lab 8.1 Resolve Errors in a Sample Project
	1. In the Project Manager, double-click the Broken Links folder to expand it.
	2. Choose FileÆExit to close RoboHelp.
	Copy the Sample Project to Your HTMLHELP Directory
	3. Insert the course diskette in a floppy drive.
	4. In Windows Explorer, copy the folder named errors from the course diskette into the HTMLHELP folder on your C: drive.
	5. In Windows Explorer, navigate to the C:\HTMLHELP\errors folder, and then open the project it contains by double-clicking the solitaire.mpj file.
	6. Click the TOC tab, and expand all three books in the TOC.
	7. In the Project Manager, expand the Broken Links folder.
	8. Click Generate Primary Layout .
	9. In the Result dialog box, click Done.
	10. Review the messages in the Output View to see if RoboHelp reported any errors while generating the Help system.
	11. Click View Primary Layout to open the Help system in the HTML Help Viewer.
	12. Inspect the Contents tab in the Help system.
	13. Inspect the “Welcome to Solitaire” topic.

	Resolve the First Broken Link
	14. In the Project Manager, verify that the Broken Links folder is expanded, listing two broken links.
	15. Choose ToolsÆResolve Broken Links.
	16. Click Close to dismiss the “Resolve Broken Links” dialog box.
	17. In the Project Manager, look for the “Setting Solitaire Options” topic.
	18. In Windows Explorer, inspect the contents of the directory C:\HTMLHELP\errors\Procedures.
	19. In the Project Manager, open the “HTML Files (Topics)” folder, and then click the Procedures folder to select it.
	20. Choose FileÆImportÆHTML File.
	21. In the Open dialog box, navigate to the C:\HTMLHELP\errors\Procedures directory, and then double-click the Setting Options.htm file.
	22. Click No to avoid overwriting your project’s CSS file.
	23. Click OK to acknowledge the alert.
	24. Choose ToolsÆResolve Broken Links.
	25. In the Resolve Broken Links dialog box, do the following:
	26. Double-click the “set game options” hyperlink to open it for editing.
	27. In the Hyperlink dialog box, choose “Setting Solitaire Options” from the Select Destination (File or URL) list, and then click OK.
	28. Choose ToolsÆResolve Broken Links, and then click Procedures\Setting Solitaire Options to select it.
	29. Close the “Resolve Broken Topics” dialog box.
	30. On the toolbar, click Save All .
	31. Choose ToolsÆResolve Broken Links, and then click Procedures\Setting Solitaire Options to select it.
	32. In the References to Selected Topics List, click Setting Solitaire Options to select it, and then click the Edit button. The book icon indicates this reference is to a TOC entry.
	33. In the TOC Page Properties dialog box, choose the “Setting Solitaire Options” topic, and then click OK.
	34. On the toolbar, click Save All .
	35. Check the Broken Links folder in the Project Manager.
	Resolve the Second Broken Link
	36. Choose ToolsÆResolve Broken Links.
	37. Close the Resolve Broken Links dialog box.
	38. In the Project Manager, look for the “Game Menu” topic.
	39. Click the TOC tab .
	40. Delete the “Game Menu” page from the TOC.

	Check to See If All Topics Are Used in Your Project
	41. Choose ToolsÆReportsÆUnreferenced Topics.
	42. Add the “Undoing a Move” topic to the “Playing the Game” book in the TOC.
	43. Re-generate the Unreferenced Topics report to check your work.
	44. Compile and run the Help file to check your work.

	Close the Sample Project and Re-open Your Project
	45. Choose FileÆClose Project to close the sample Help project.
	46. Choose FileÆOpen Project, and then re-open your Solitaire Help project (in C:\HTMLHELP\solitaire).


	Unit Summary
	. The Output View appears at the bottom of the RoboHelp window and displays status messages when you generate your Help system. You can display or hide the Output View by choosing ViewÆOutput View.
	Unit 9 Editing and Deleting

	Unit Overview
	In this unit, you will learn how to:
	. Edit and delete hyperlinks



	Editing Topics in RoboHelp
	RoboHelp provides two editors you can use to edit the contents of your Help topics: the WYSIWYG Editor, which you have used in t...
	A Few Notes About the TrueCode Editor
	If you know HTML, you can use the TrueCode editor to make code changes in your topic files “behind the scenes.” If you decide to do this, though, there are several things to keep in mind:
	. First, the HTML code that RoboHelp produces has a number of “quirks” that will seem unusual to someone familiar with standard HTML coding practices.
	. Second, RoboHelp does not always preserve code changes you make directly in the TrueCode editor.

	Figure 9.1 shows a portion of the HTML file for the “Welcome to Solitaire” topic opened in the TrueCode Editor.
	Figure 9.1 The TrueCode Editor



	RoboHelp Components in this Unit
	In this unit, you will continue to work with WYSIWYG Editor and with the Topic Properties and TOC Page Properties dialog boxes.


	Lab 9.1 Edit Topics and Preview Changes
	1. Add the following text to the “Setting Solitaire Options” topic:
	2. Create a hyperlink from the text Game menu to the “Game Menu” topic.
	3. Click View Selected Item to preview the modified topic.
	4. Close the preview window.
	5. Add the following text to the “Keeping Score” topic (again using the Create a Numbered List toolbar button to number the steps):
	6. Create a hyperlink from the text Game menu to the “Game Menu” topic, and then create popup hyperlinks from Standard and Vegas to the “Standard Scoring” and “Vegas Scoring” topics.
	7. Add the following text to the “Starting a Brand New Game” topic. Use the Heading 2 style for the two procedure headings (“To start Solitaire…” and “To start a new game…”).
	8. Create a standard hyperlink from the text Game menu to the “Game Menu” topic.
	9. Add the following text to the “Changing the Card Design” topic, using the Create a Numbered List toolbar button to format the numbered list:
	10. Create a hyperlink from the text Game menu to the “Game Menu” topic.
	11. In the “Playing the Game” topic, create a hyperlink from the text Game menu to the “Game Menu” topic, and then create popup ...
	12. Generate your Help system and check your work.

	Lab 9.2 Add and Format a Table
	1. Create a new topic in the Overviews folder and name the topic Keyboard Shortcuts.
	2. Replace the placeholder topic text by typing:
	3. Press Enter to start a new paragraph.

	Insert a Basic Table
	4. Click the Insert Table toolbar button and drag to insert a 4 x 2 table, as shown in the illustration to the right.
	5. Type data in the table, as shown in the following illustration:

	Set Formatting Properties for the Table
	6. Right-click somewhere within the table, and then choose Table Properties from the right-click menu.
	7. Click the Cell Borders button.
	8. In the Cell Borders dialog box, select None under Setting, and then click OK.
	9. In the Table dialog box, click the Table Borders button.
	10. In the Table Borders dialog box, do the following:
	a. From the Style list, choose Double.
	b. From the Color list, choose Navy.
	c. Set the Width to 4px.
	d. Click OK.
	11. In the Table dialog box, click the Margins button.
	12. In the Margins dialog box, set the Top margin to 15px, and then click OK.

	13. In the Table dialog box, set Table caption to Above.
	14. Click OK.
	15. Click in the table caption area, and then type Solitaire Shortcuts.
	16. Click View Selected Item to preview your table. When you’re finished, close the preview window.



	Format the Heading Cells
	17. Select the two heading cells (“To” and “Press”), and then click Apply Bold .
	18. With the heading cells still selected, choose FormatÆBorders and Shading.
	19. In the Borders and Shading dialog box, do the following:
	a. Click the Shading tab.
	b. From the Color list, choose Silver.
	c. Click OK.
	20. Click View Selected Item to preview your table. When you’re finished, close the preview window.


	Add a Column and Rearrange Text
	21. Click somewhere in the second column of the table, and then choose TableÆInsertÆColumn.
	22. Double-click to select the “Press” column heading, and then drag it from column 3 to column 2, as shown in the following illustration:
	23. Repeat Step 22 to move “Alt+G” from column 3 to column 2, as shown in the following illustration:
	24. Repeat Step 22 to move the remaining occurrences of Alt+G from column 3 to column 2.
	25. In the heading cell for column 3, type:
	26. Click View Selected Item to preview your table.
	27. Select the heading row, and then click the Align Selected Table Contents on Bottom toolbar button.
	28. Click View Selected Item again

	Resize Columns
	29. Drag the border between column 2 and column 3 to make column 3 wider.
	30. Choose TableÆAutoFitÆAutoFit to Window.
	31. Click View Selected Item to preview your table.
	32. Choose TableÆAutoFitÆAutoFit to Contents.

	33. Click View Selected Item to preview your table.
	34. Close the preview window.

	Lab 9.3 Edit and Delete Hyperlinks
	1. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	2. Type over the start a brand new game hyperlink to change it to:
	3. Type over the rules of Solitaire hyperlink to change it to:
	4. Open the “Keeping Score” topic in the WYSIWYG Editor.
	5. Right-click in the second Vegas popup, and then choose Remove Popup from the right-click menu.
	6. Generate your Help system and check your work.



	Lab 9.4 Change a Topic Title
	1. In the Project Manager, expand the HTML Files (Topics) folder.
	2. Choose ViewÆBy Topic Title.
	3. In the Project Manager, right-click the “Starting a Brand New Game” topic, and then choose Properties from the right-click menu.
	4. Change the Topic Title to:
	5. Click OK.
	6. In the Project Manager, double-click the “Starting a New Game” topic to open it in the WYSIWYG Editor.
	7. In the “Starting a New Game” topic, change the topic heading to:
	8. In the TOC Composer, open the “Playing the Game” book.
	9. In the “Playing the Game” book, right-click the “Starting a Brand New Game” page, and then choose Properties from the right-click menu.
	10. In the “Page Properties” dialog box, change the Page Title to:
	11. Click OK.
	12. Generate your Help system and check your work.

	Lab 9.5 Delete a Topic
	1. In the Project Manager, open the Overviews folder.
	2. Right-click the “Game Menu” topic, and then choose Delete from the right-click menu.
	3. Click Yes.
	4. Generate your Help system and check your work.

	Lab 9.6 Rename a Topic File
	1. Choose ViewÆBy File Name.
	2. In the Project Manager, open the Procedures folder, click Starting_a_Brand_New_Game.htm, pause briefly, and then click it again.
	3. Type Starting_a_New_Game.htm, and then press Enter.

	Lab 9.7 Update Topic Properties
	1. In the Topics List, change the Status of the following topics to Ready for Review:
	2. Generate the Project Status report, review the contents of the report, and then click the Close button to close the report.
	3. Save your work.

	Unit Summary
	. While editing a topic in the WYSIWYG Editor, you can preview the topic without generating your Help system by clicking the View Selected Item toolbar button.
	- You can change topic titles and file names in the Project Manager or in the Topic Properties dialog box.
	Unit 10 Working with Style Sheets


	Unit Overview
	In this unit, you will learn how to:
	. Use the standard style sheets provided with RoboHelp



	What Is a Style Sheet?
	A style sheet is a collection of instructions that control the layout and appearance of an HTML topic, including the font size a...
	. By defining styles in an external style sheet and then associating the style sheet with any number of HTML files. External sty...

	Creating Style Sheets in RoboHelp
	RoboHelp includes its own style sheet editor, illustrated in Figure 10.4 on page 73. Defining styles in RoboHelp is similar to defining styles in Microsoft Word.

	Style Sheets Provided with RoboHelp
	RoboHelp includes four standard style sheets in each Help project you create:
	. default.css


	Linking Topics to Style Sheets
	You can link a style sheet to each topic in a Help project, either by choosing it from a drop-down list in the WYSIWYG Editor or by selecting it on the Appearance tab in the Topic Properties dialog box.
	To apply a style sheet in the WYSIWYG Editor:
	Figure 10.1 Style Sheet List in the WYSIWYG Editor

	To assign a style sheet in the Topic Properties dialog box:
	1. Select a single topic in the Project Manager, or select one or more topics in the Topics List.
	2. Right-click the selected topic or topics, and then choose Properties from the right-click menu.
	3. On the Appearance tab in the Topic Properties dialog box, select style sheet from the Style Sheet list.
	4. Click Apply or OK.
	Figure 10.2 Topic Properties Dialog Box, Appearance Tab


	Applying Styles in a Topic
	Once you’ve linked a topic to a style sheet, you can apply styles defined in that style sheet to elements in the topic. To apply paragraph and character styles, you use the Apply Styles list, as illustrated in Figure 10.2.
	Figure 10.3 The Apply Styles List

	To apply a paragraph style:
	1. Click within a paragraph or drag to select multiple paragraphs.
	2. Choose a paragraph style from the Apply Styles list.

	To apply a character style:
	1. Drag to select a text range.
	2. Choose a character style from the Apply Styles list.


	RoboHelp Components in this Unit
	This unit introduces the Styles dialog box, which you use to define styles and style sheets in a Help project. From the Styles d...
	Figure 10.4 Styles Dialog Box




	Lab 10.1 Link Topics to Standard Style Sheets
	1. Display the Project Manager and the Topics List.
	2. In the Topics List, select all topics in the project. Do not select the web URL http://www.Solitaire.com.
	3. Right-click the selected topics, and then choose Properties from the right-click menu.
	4. In the Topic Properties dialog box, click the Appearance tab.
	5. In the Style Sheet list, click MS_Help.css., and then click OK.
	6. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	7. Generate your Help system and check the results.
	8. Close the HTML Help window.
	9. In the Project Manager, expand the Style Sheets folder.
	10. In the Topics List, select all the procedure topics (but none of the other topics).
	11. Repeat Steps 3-5 to apply the w95help.css style sheet to all the procedure topics.
	12. Generate your Help system and check the results.
	13. Close the HTML Help window.
	Lab 10.2 Create a Style Sheet and Define Paragraph Styles
	Create a New Style Sheet
	1. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	2. Click the Assign Style Sheet button in the WYSIWYG Editor pane, and then choose New from the drop-down list, as shown in the following illustration:
	3. In the Create New Style Sheet dialog box, type sol-styles in the Name box, and then click Create.

	Redefine the Normal Paragraph Style
	4. In the Styles list, click the Normal style to select it, and then click the Modify button.
	5. In the Modify Style dialog box, click the Format button, and then choose Font from the drop-down menu.
	6. In the Font dialog box, change the font to Verdana 9pt, as shown in the following illustration:
	7. Click OK to close the Font dialog box.
	8. Click the Format button, and then select Paragraph from the drop-down menu.
	9. In the Paragraph dialog box, change the Spacing Before to 9.5pt.
	10. Click OK twice to return to the Styles dialog box.
	11. Click Close to dismiss the Styles dialog box.
	12. Click the Save All toolbar button.
	13. Generate your Help system and check the results.
	14. Close the HTML Help window.

	Redefine the Heading 1 and Heading 2 Paragraph Styles
	15. In the Project Manager, double-click the sol-styles.css style sheet to open it for editing.
	16. Make the following changes to the Heading 1 and Heading 2 paragraph styles:
	a. Set the Heading 1 style to use Verdana, 12 point, Navy (color), Bold.
	b. Set the Heading 2 style to use Verdana, 10 point, Navy, Bold.
	17. Click OK as necessary to return to the Styles dialog box.
	18. Click Close to dismiss the Styles dialog box.
	19. Generate your Help system and check the results.
	20. Close the HTML Help window.



	Lab 10.3 Link Topics to the New Style Sheet
	1. Display the Topics List.
	2. Select all topics in the project.
	3. Right-click the selected topics, and then choose Properties from the right-click menu.
	4. From the Style Sheet list on the Appearance tab, choose sol- styles.css, and then click OK.
	5. Generate your Help system and check the results.
	6. Close the HTML Help window.


	Lab 10.4 Create and Apply Paragraph Styles
	1. In the Project Manager, double-click the sol-styles.css style sheet to open it for editing.
	2. In the Styles dialog box, click the New button.
	3. In the New Style dialog box, type Bulleted-List in the Name box, and then click OK.
	4. With the Bulleted-List style selected, click the Modify button to edit its definition.
	5. In the Modify Style dialog box, click the Format button, and then choose Paragraph from the drop-down menu.
	6. In the Paragraph dialog box, change Indentation Left to -18pt, and change Spacing Before to 5pt, as shown in the following illustration:

	7. Click OK.
	8. In the Modify Style dialog box, click the Format button, and then choose Bullets and Numbering from the drop-down menu.
	9. In the Bullets and Numbering dialog box, click the Bulleted tab, choose the square bullet style, and then click OK.
	10. Click OK to return to the Styles dialog box.
	11. Repeat the general actions described in Steps 2-10 to create a style for numbered lists. Follow these guidelines:
	12. Click OK and Close to dismiss all open dialog boxes.
	13. Click the Save All toolbar button.
	14. Use the WYSIWYG Editor to apply the Bulleted-List style to all bulleted list items in all topics in the project.

	15. Use the WYSIWYG Editor to apply the Numbered-List style to all numbered lists in the project. You will find numbered lists in most of the procedure topics.
	16. Generate your Help system and check your work.
	17. Close the HTML Help window.


	Lab 10.5 Modify Document Styles
	Set Global Font and Background Styles
	1. Open the sol-styles.css style sheet for editing.
	2. In the Styles list in the Styles dialog box, click : : Background + Text (BODY), and then click Modify.
	3. In the Modify Style dialog box, click the Format button, and then select Font from the drop-down menu.
	4. Set the font to Verdana 9pt, and then click OK.
	5. In the Modify Style dialog box, click the Format button, and then choose Borders and Shading from the drop-down menu.
	6. In the Borders and Shading dialog box, click the Shading tab, and then choose Custom from the Color list.
	7. In the New Custom Color dialog box, type Background as the color name, and then click OK.
	8. In the Color dialog box, set the Red, Green, and Blue values to 255, 255, and 204, respectively, as shown in the following illustration:
	9. Click OK and Close, as necessary, to dismiss all open dialog boxes.
	10. Generate your Help system and check the results.
	11. Unless you really like the background color, change it back to white.

	Set Global Link Colors
	12. Open the sol-styles.css style sheet for editing.
	13. In the Styles dialog box, click Hyperlink (active), and then click Modify.
	14. In the Modify Style dialog box, click the Format button, and then select Font from the drop-down menu.
	15. In the Font dialog box, change the Font style to Bold, change the Font color to Maroon, and then click OK.
	16. Repeat Steps 13-15 to change the Font style for Hyperlink (hovered) to Bold.
	17. Click OK and Close, as necessary, to close all open dialog boxes.
	18. Generate your Help system and check the results.
	19. Close the HTML Help window.

	Lab 10.6 Define a Style for Notes and Tips
	1. Open the sol-styles.css style sheet for editing.
	2. Use the Styles dialog box to create a new style named Note based on the Normal style. Define the Note style as follows:
	3. Close the Styles dialog box.
	4. Open the “Keeping Score” topic in the WYSIWYG Editor
	5. Delete the line containing the “Tip!” heading.
	6. At the beginning of the paragraph that starts “If you choose Vegas scoring,” type:
	7. Select the text Tip! and click the Apply Bold toolbar button.
	8. Apply the Note style to the paragraph.
	9. Click View Selected Item to preview the topic.
	10. Close the preview window.
	11. Open the sol-styles.css style sheet for editing.
	12. Select the Note style in the Styles list, and then click Modify.
	13. In the Modify Style dialog box, click Format, and then select Borders and Shading from the drop-down menu.
	14. In the Borders and Shading dialog box, do the following:
	a. Click the Borders tab.
	b. Under Setting, choose Box.
	c. From the Style list, choose Solid.
	d. From the Color list, choose Aqua.
	e. Set the Width to 8px.
	f. Click OK when the dialog box looks like this:

	15. Click OK and Close, as necessary, to close all open dialog boxes.
	16. Click anywhere in the topic, and then click View Selected Item to preview it.
	17. Close the preview window.



	Lab 10.7 Define a Style for Result Statements
	1. Open the “Setting Solitaire Options” topic in the WYSIWYG Editor.
	2. Click at the end of the paragraph containing step 1, press Enter to start a new line, and then type the following text:
	3. Open the sol-styles.css style sheet for editing.
	4. In the Styles dialog box, click New to create a new style, and give the new style the following attributes:
	5. Close the Styles dialog box, and then apply the Numbered-List- Cont style to the result statement.
	6. Right-click the step that begins, “In the Options dialog box, click…,” and then choose Bullets and Numbering from the right- click menu.
	7. In the Bullets and Numbering dialog box, set Restart numbering at to 2.
	8. Click View Selected Item to preview the topic.

	Unit Summary
	. A style sheet is a collection of formatting instructions typically stored in a text file with a .css extension.
	Unit 11 Defining and Using Custom Windows

	Unit Overview
	In this unit, you will learn how to:
	. Define a custom window



	Defining a Custom Window
	You can define one or more custom windows in your Help project and then use the custom windows to display Help topics. By defini...
	Figure 11.1 Window Properties Dialog Box
	. Specify a Window Name. You use the window name in RoboHelp to refer to the window, and your application developers may use it when coding context-sensitive Help calls.
	- Enable or disable the five tabs in the navigation pane (Contents, Index, Search, Favorites, Glossary)
	- Hide the navigation pane when the Help system is opened (particularly useful for context-sensitive Help)

	. Select the toolbar buttons to be displayed in the window.

	Using a Custom Window as the Default Window
	Once you have defined a custom window, you can designate it as the default window for your project. You can choose a default window for an HTML Help project using the HTML Help Options dialog box, as shown in Figure 11.2.
	Figure 11.2 HTML Help Options Dialog Box



	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. The Window Properties Dialog Box

	The Window Properties Dialog Box
	You use the Window Properties dialog box, shown in Figure 11.1 on page 85, to create and set the properties of the windows in which your Help topics will be displayed.

	The HTML Help Options Dialog Box
	You use the HTML Help Options dialog box, shown in Figure 11.2 on page 86, to set basic options for your HTML Help layout, including:
	. The output directory and file name


	The HTML Help - Advanced Settings Dialog Box
	You use the HTML Help - Advanced Settings Dialog Box to customize the appearance and behavior of the TOC and Index tabs in your HTML Help system.
	Figure 11.3 HTML Help - Advanced Settings Dialog Box




	Lab 11.1 Define and Use a Custom HTML Help Window
	Create a Custom Window Definition
	1. In the Project Manager, expand the Windows folder.
	2. Create a new window definition by doing one of the following:
	3. In the Window Properties dialog box, do the following:
	a. In the Window Name box, type solitaire.
	b. In the Caption box, type Solitaire Help.
	c. Resize and reposition the sample window. You can resize it by dragging its corners; you can reposition it by dragging its titlebar.
	d. Under Tri-pane Tabs and Windows, select TOC & Index, Search Tab, and Favorites.
	e. Under Tri-pane Options, select Auto Synchronize TOC.
	f. Click OK when the dialog box looks like this:
	4. Generate your Help system and check the results.


	Lab 11.2 Set the Default Window for Your Project
	1. In the Project Manager, expand the Single Source Layouts folder.
	2. Right-click Microsoft HTML Help (Primary Layout), and then choose Properties from the right-click menu.
	3. In the HTML Help Options dialog box, choose solitaire from the Default Window list, and then click Save.
	4. Generate your Help system and check the results.
	5. If you are dissatisfied with the dimensions or positioning of the new window, you can change them as follows:
	a. In the Project Manager, open the Windows folder.
	b. Double-click the solitaire window.
	c. In the Window Properties dialog box, adjust the size and position of the window to suit your needs.
	d. Click OK.
	e. Generate your Help system and check the new window size and position.

	Lab 11.3 Customize the TOC Pane
	1. Run your Help system and take a close look at the behavior and appearance of the TOC:
	2. Close the HTML Help Viewer.
	3. In the Project Manager, expand the Single Source Layouts folder, right-click Microsoft HTML Help (Primary Layout), and then choose Properties from the right-click menu.
	4. In the HTML Help Options dialog box, verify that “Welcome to Solitaire” is selected as the Default Topic.
	5. Click the Advanced button.
	6. In the HTML Help - Advanced Settings dialog box, click the TOC Styles tab.
	7. Select Always Show Selection, and then click OK.
	8. Click Save to save the changes to your HTML Help layout.
	9. Generate and view your HTML Help system.
	10. Experiment with the following TOC style options, generating your Help project and viewing the TOC after each change:
	11. On the TOC Styles tab in the HTML Help - Advanced Settings dialog box, click Select Font.
	12. In the Font dialog box, choose Verdana 9, and then click OK.
	13. Click OK and then Save to save the changes to your HTML Help layout.
	14. Generate your Help system and check the results.

	Unit Summary
	. You can create one or more custom window definitions and use them to display the topics in your Help system.
	Unit 12 Working with Images

	Unit Overview
	In this unit, you will learn how to:
	. Insert images in a Help topic



	Image File Formats
	Literally hundreds of different file formats have been developed for representing graphic images in digital form. RoboHelp and HTML Help provide native support for three popular file formats:
	. Graphics Interchange Format (GIF)

	Graphics Interchange Format (GIF)
	GIF is a compressed image file format in which you can store images that contain up to 256 unique colors. One of these colors ca...

	Joint Photographic Experts Group (JPEG) Format
	JPEG is a compressed format in which you can store images that contain up to 16.7 million unique colors-far more colors than the human eye can distinguish. The JPEG format does not support transparency.

	Portable Network Graphic (PNG) Format
	PNG is a compressed format that was invented specifically for use on the web. You can create PNG files with 256 colors or 16.7 million colors.

	Adding Images to Help Topics
	Many users are accustomed to pasting images into documents created in Microsoft Word. You cannot paste images into Help topics. Instead, you locate the image file on your computer and insert a reference to the file.

	Scaling and Resizing Images
	Occasionally, an image file may not be exactly the right size for use in a particular Help topic. In this case, you can scale or resize the image.
	. When you scale an image, you embed information in your Help topic that specifies the size at which you want the image to be di...


	Creating Imagemaps
	An imagemap defines one or more regions in an image that are hyperlinked to other locations, such as another Help topic or a web...


	RoboHelp Components in this Unit
	This unit introduces the following components of RoboHelp:
	. Image Dialog Box

	Image Dialog Box
	You use the Image dialog box whenever you insert an image in a Help project.
	Figure 12.1 Image Dialog Box


	ReSize Utility
	You use the ReSize utility to resize and/or downsample images.
	Figure 12.2 ReSize Utility




	Lab 12.1 Insert an Image
	1. Insert the course diskette in your floppy disk drive.
	2. Open the “Welcome to Solitaire” topic in the WYSIWYG editor.
	3. Click in a blank line at the end of the topic.
	4. Click the Insert Image toolbar button.
	5. Click the Browse button.
	6. In the Select Image File dialog box, navigate to and then select the sol-flow.gif file on the course diskette; then, click OK.
	7. Click OK in the Image dialog box.
	8. In the Project Manager, expand the Images folder.
	9. Click the Save All toolbar button.
	10. Generate your Help system and check the results.

	Lab 12.2 Use a Custom Bullet Image
	Define a Style for Single-step Procedures
	1. Open the sol-styles.css style sheet for editing.
	2. In the Styles dialog box, click New.
	3. In the New Style dialog box, type OneStep in the Name box.
	4. Click Format, and then choose Paragraph from the drop-down menu.
	5. Set the Left Indentation to -18pt, and then click OK.
	6. Click Format, and then choose Bullets and Numbering from the drop-down menu.
	7. In the Bullets and Numbering dialog box, click the Bulleted tab, and then click the Browse button next to the Bullet image box.
	8. Click the Browse button, navigate to and select the onestep.gif file on the course diskette, and then click Open.
	9. Click OK in the Image dialog box.
	10. Click OK in two successive dialog boxes, and then click Close to close the Styles dialog box.

	Apply the OneStep Style
	11. Open the “Starting a New Game” topic in the WYSIWYG Editor.
	12. Apply the OneStep style to the paragraphs that begin, “On the Start menu” and “On the Game menu.”
	13. Click View Selected Item to preview the topic.
	14. Generate your Help system and navigate to the “Starting a New Game” topic.
	Add the Image File to Baggage
	15. In the Project Manager, right-click the Baggage Files folder, and then choose New Baggage File from the right-click menu.
	16. In the Select Baggage File dialog box, select the onestep.gif file in your Solitaire project folder, and then click Open.
	17. Generate your Help system and navigate to the “Starting a New Game” topic.



	Use the OneStep Style in Another Topic
	18. Open the “Undoing a Move” topic in the WYSIWYG Editor.
	19. Type the following topic text:
	20. Apply bold to the word Note.
	21. Apply the OneStep style to the paragraph that reads, “On the Game menu, click Undo.”
	22. Apply the Note style to the paragraph that contains the note.
	23. Generate your Help system and check the results.


	Lab 12.3 Create Hyperlinked Images
	1. Open the “Scoring Information” topic in the WYSIWYG Editor.
	2. Type the following text, starting on a blank line beneath the existing topic text:
	3. Apply the Heading 2 style to the “Find out more …” heading.
	4. Click at the beginning of the line that reads “Setting scoring options.”
	5. Click the Insert Image toolbar button.
	6. Select and insert the document.gif image file from the course diskette, and then press the space bar to separate the image from the text.
	7. Click the Save All toolbar button.
	8. In the Project Manager, select the document.gif file, and then drag and drop it to the right of the line that reads, “Setting other game options.”
	9. Use the space bar to separate the image from the text.
	10. Click the first document image to select it.
	11. Click the Insert Hyperlink toolbar button.
	12. In the Hyperlink dialog box, choose the “Keeping Score” topic in the Select destination (file or URL) list, and then click OK.
	13. Repeat Steps 10-12 to link the second document image to the “Setting Solitaire Options” topic.
	14. Generate your Help system and check the results.

	Lab 12.4 Create and Use Screen Captures
	Create a Screen Capture
	1. Start Solitaire.
	2. Press Alt+PrintScreen. (Hold down the Alt key while pressing the Print Screen key.)
	3. In RoboHelp, click the Tools tab .
	4. In the Tools tab, double-click the ReSize icon.
	5. In the ReSize window, choose EditÆPaste.
	6. In the Image Properties dialog box, click the Properties tab, and set the Colors value in the Scaled column to 256, as shown in the following illustration:
	7. In ReSize, choose FileÆSave As.
	8. In the Save As dialog box:
	9. Switch back to Solitaire.
	10. In Solitaire, choose GameÆDeck.
	11. Press Alt+PrintScreen.
	12. Switch to ReSize, and then choose EditÆPaste.
	13. Use ReSize as before to set the number of colors to 256 and save the capture of the Deck dialog box in a file named db-deck.gif in your Solitaire Help project folder.
	14. Switch back to Solitaire, and then click Cancel in the Select Card Back dialog box.
	15. In Solitaire, choose GameÆOptions.
	16. Press Alt+PrintScreen.
	17. Switch to ReSize, and then in ReSize choose EditÆPaste.
	18. Use ReSize as before to save the capture of the Options dialog box in a file named db-options.gif in your Solitaire Help project folder.
	19. Close ReSize.
	20. Close Solitaire.

	Add the Screen Capture to a Topic
	21. In RoboHelp, open the “Solitaire Window” topic in the WYSIWYG Editor.
	22. Click in a blank line at the bottom of the topic text.
	23. Insert the sol-window.gif file.
	24. Click the Save All toolbar button.
	25. Generate your Help system and check the results.
	26. Close the HTML Help window.



	Lab 12.5 Scale Images
	Scale an Image by Dragging
	1. In RoboHelp, open the “Solitaire Window” topic in the WYSIWYG Editor.
	2. Click the image to select it.
	3. Drag the bounding box in the lower-right corner of the image to reduce its size slightly.
	4. Click View Selected Item to preview the topic.
	5. Close the preview window.

	Reset an Image to Its Actual Size
	6. In the WYSIWYG Editor, right-click the image, and then choose Reset Size from the right-click menu.

	Scale an Image by Setting Absolute Pixel Dimensions
	7. In the WYSIWYG Editor, double-click the Solitaire window image.
	8. In the Image dialog box, click the Size button.
	9. In the Size dialog box, do the following:
	10. Click View Selected Item to preview the topic.
	11. Close the preview window.


	Lab 12.6 Resize Images
	1. Open the “Solitaire Window” topic in the WYSIWYG Editor.
	2. Reset the image to its actual size.
	3. Click the Tools tab.
	4. In the Tools tab, double-click the ReSize tool.
	5. In ReSize, choose FileÆOpen, navigate to and select the sol-window.gif file, and then click Open.
	6. In the Image Properties dialog box, make sure that Keep aspect ratio is selected, and then choose Percent from the Units list.
	7. Reduce the Width or Height setting to 80.
	8. Click Apply.
	9. Choose FileÆSave, and then FileÆExit.
	10. In RoboHelp, right-click the Solitaire Window image, and then choose Reset Size from the right-click menu.
	11. Click View Selected Item to preview the topic with the resized image.


	Lab 12.7 Create Imagemaps
	Create Two Additional Help Topics
	1. Create a new topic, entering Did You Win? as the topic title.
	2. Type the following topic text:
	3. Create another new topic, entering Celebrate as the topic title.
	4. Type the following topic text:
	5. On a blank line beneath the topic text, insert the champagne.gif image file from the course diskette.
	6. Click the Save All toolbar button.

	Define an Imagemap for the Solitaire Flowchart
	7. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	8. Right-click the flowchart image, and then choose Insert Image MapÆRectangle from the right-click menu.
	9. Click and drag and rectangle around the box in the image that is labeled “Start the Solitaire application.”
	10. In the Select destination (file or URL) list, select the “Starting a New Game” topic, and then click OK.
	11. Repeat Steps 8-10 to create the following additional hotspots:
	12. Generate your Help system and check the results.
	Lab 12.8 Organize Image Files
	1. In the Project Manager, right-click the Images folder, and then choose New Folder from the right-click menu.
	2. Type Art as the name for the new folder.
	3. In the Project Manager, drag the four images files from the Images folder and drop them into the new Art folder.


	Unit Summary
	. RoboHelp and HTML Help provide native support for image files in GIF, JPEG, and PNG format.
	Unit 13 Creating an Index

	Unit Overview
	In this unit, you will learn how to:
	. Create a poor index quickly and automatically using the Smart Index Wizard



	What is a Help Index?
	A Help index is similar to the index in a book. A comprehensive, well designed index will help users find information in your Help file. In a running HTML Help system, the index appears in the Index tab, as shown in Figure 13.1.
	Figure 13.1 Help Index in HTML Help


	Components of a Help Index
	A Help index consists of index keywords, of which there are two types.
	. Primary index keywords are at the highest level in the index.
	. Index subkeywords are nested under other keywords.

	Creating a Help Index
	You create a Help index by adding index keywords to your project, and then associating topics with the keywords. RoboHelp offers several methods for doing this:
	. You can select a word or phrase in the WYSIWYG Editor, right- click the selection, and then choose Add Index Keyword from the right-click menu.
	Figure 13.2 Topics Found Dialog Box from the Index Tab




	The Importance of Help Indexes
	A frustrated online Help user once said, “An index maps the words of a user’s distress to the syntax of an application.” This wo...
	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. Smart Index Wizard

	Smart Index Wizard
	The Smart Index Wizard is a utility that searches through your Help topics and suggests index keywords and phrases. The Smart Index Wizard can create an entire index automatically or prompt you to confirm its suggestions one topic at a time.
	Figure 13.3 Smart Index Wizard (First Page)


	The Index Designer
	The Index Designer is a point-and-click tool you use to build and edit the index in a Help project.
	Figure 13.4 The Index Designer


	Index Keyword Properties Dialog Box
	You use the Index Keyword Properties Dialog Box to set or change the properties of an index keyword.
	Figure 13.5 Index Keyword Properties Dialog Box





	Lab 13.1 Generate an Index Using the Smart Index Wizard
	Generate an Index Without Human Intervention
	1. Choose ToolsÆSmart Index Wizard.
	2. In the first Smart Index Wizard dialog box, accept the defaults and click Next.
	3. In the second Smart Index Wizard dialog box, select Automatically add index keywords for all topics, and then click Finish.
	4. Generate your Help system and review the index.
	5. In the Index Designer, select the first index keyword that the Smart Index Wizard created.
	6. Press the Delete key and hold it down until all the index keywords are gone.


	Make the Smart Index Wizard a Little Less Dumb
	The Smart Index Wizard offers several configuration options you can use to improve the quality of the index it generates. The results are still not great, but they are better.
	7. Choose ToolsÆSmart Index Wizard.
	8. In the first Smart Index Wizard dialog box, clear the Capitalize all new index keywords option, select the Use custom search settings option, and then click the Settings button.
	9. In the Smart Index Settings dialog box, do the following:
	a. Clear the following options: Words with numbers, Words not in the dictionary, Include Verb phrases.
	b. Select the Adjectives option.
	c. Click OK when the dialog box looks like this:

	10. Click Next.
	11. In the second Smart Index Wizard dialog box, select the Confirm adding index keywords for each topic option, and then click Next.
	12. With the Ace keyword selected, click Always Ignore.
	13. Select the King keyword, and then click Always Ignore.
	14. To determine which keywords RoboHelp adds for the topic, do any of the following:
	15. When you’ve finished selecting keywords, click Next to proceed to the next topic.
	16. Repeat Steps 14-15 until you have reviewed and revised all of the suggestions offered by the Smart Index Wizard.
	17. Generate your Help system and check the index.
	18. In the Index Designer, select the first index keyword that the Smart Index Wizard created.
	19. Press the Delete key and hold it down until all the index keywords are gone.



	Lab 13.2 Create a Real Index
	Add Index Keywords from the WYSIWYG Editor
	1. Open “The Rules” in the WYSIWYG Editor.
	2. Click the Index tab in the lower left.
	3. In the WYSIWYG Editor, select the word “Rules” in the topic title.
	4. Right-click the selection, and then choose Add Index Keyword from the right-click menu.
	5. In the Index Designer, right-click the “Rules” keyword, and then choose Rename from the right-click menu.
	6. Change the keyword from Rules to rules.

	Create Index Keywords in the Index Designer
	7. Create index keywords in the Index tab, following the “Index Plan” on page 116.
	a. Click in the text box toward the top of the Index Designer.
	b. Type the first primary index keyword, and then press Enter (or click the Add button).
	c. Type the next primary index keyword, and then press Enter (or click the Add button.)
	d. Continue until you have entered all the primary index keywords.
	e. To create an index subkeyword, select a primary index keyword, and then click New Index Subkeyword on the Index Designer toolbar.
	f. Move keywords around as necessary by dragging and dropping or by using the directional arrow toolbar buttons.

	Assign Topics to Index Keywords
	8. Click the Show Topics button in the Index Designer.
	9. Assign topics to keywords, following the “Index Plan” on page 116. To assign topics to keywords:
	a. Click a keyword in the Index Designer.
	b. Select and then drag one or more topics from the Topics List and drop them in the Topics for pane beneath the keyword pane.
	10. Generate your Help system and check the results.
	11. Revise as necessary.
	12. Repeat Steps 9-11 until you are satisfied with the index you have created.

	Generate an Index Report
	13. Choose ToolsÆReportsÆIndex.
	14. Review the Index report.
	15. In the Reports dialog box, click the Options button.
	16. Generate and review each of the three types of Index report.
	17. Click the Close button to close the report window.


	Add a Cross-reference Keyword
	18. Add a new index keyword:
	19. Double-click the deck options keyword.
	20. In the Index Keyword Properties dialog box, select Cross- reference, and then choose card deck from the drop-down list, as shown in the following illustration:
	21. Click OK.
	22. Generate your Help system and check the results.
	23. Close the HTML Help window.
	Index Plan
	Use the following index plan to build your index.
	Table 13.1 Index Plan for Lab 13.2



	Unit Summary
	. A Help index presents a list of keywords that users can select in order to navigate to the topics in a Help system. The keywords are usually listed in alphabetical order.
	- Typing them into the keyword box in the Index Designer
	- Selecting a keyword in the Index Designer, and then dragging one or more topics from the Topics List and dropping them in the Topics for area in the Index Designer
	Unit 14 Adding Related Topics Controls


	Unit Overview
	In this unit, you will learn how to add related topics controls to Help topics to make it easier for users to find related information.


	What Is a Related Topics Control?
	A related topics control is a button or a bit of text that you insert in a Help topic and associate with other Help topics that ...
	Figure 14.1 Related Topics Control in an HTML Help System

	RoboHelp Components in this Unit
	This unit introduces the Related Topics Wizard.
	Related Topics Wizard
	The Related Topics Wizard is a series of dialog boxes that you use to add related topics controls in a Help system. The Related Topics Wizard consists of four separate pages, the first of which is shown in Figure 14.2.
	Figure 14.2 Related Topics Wizard (First Page)





	Lab 14.1 Create Related Topics Controls
	1. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	2. Click in a blank line beneath the flowchart image.
	3. Click the Insert Navigation Control toolbar button, and then choose Related Topics from the popup menu that appears.
	4. Without changing anything, click Next.
	5. On the second page of the Related Topics Wizard, double-click each of the following topics in the Topics in project list to add them to the Related topics list:
	6. Click Next.
	7. Select Pop-up menu, and then click Next.
	8. On the fourth page of the Related Topic Wizard, set the Font to Verdana 9pt bold, as shown in the following illustration:
	9. Click Finish.
	10. Click View Selected Item to preview the topic.
	11. In the “Scoring Information” topic, follow the same procedure to add a related topics control that links to the following topics:
	12. In the “Solitaire Window” topic, add a related topics control that links to the following topics:
	13. Generate your Help system and check the results.
	Unit Summary
	. Related topics controls are buttons or text links that connect one Help topic to other topics containing related information.
	Unit 15 Working with Topic Templates

	Unit Overview
	In this unit, you will learn how to:


	What Are Topic Templates?
	Topic templates are similar to templates in other applications, such as Microsoft Word. You can use a topic template to ensure that the same text or graphics appear in multiple topics and to help create a consistent look and feel throughout a project.
	. Running headers and footers that appear in all the topics to which you apply the template.


	RoboHelp Components in this Unit
	This unit introduces a change to the WYSIWYG Editor when you use it to edit a topic template.
	Figure 15.1 The WYSIWYG Editor in Template Mode



	Lab 15.1 Create a Topic Template for the Solitaire Project
	1. In the Project Manager, right-click the Templates folder, and then choose New Topic Template from the right-click menu.
	2. Type Solitaire Template in the Name box.
	3. Type Main Solitaire topic template in the Description box.
	4. Click the Appearance tab and verify that sol-styles.css is selected in the Style Sheet list.
	5. Click OK.
	6. Read the placeholder text in new template.


	Lab 15.2 Define Running Headers and Footers
	1. Click the Create or Edit Header toolbar button.
	2. Type Solitaire XP in the running header area:
	3. Click the Align Right toolbar button.
	4. Click the Create or Edit Footer toolbar button.

	5. Type the following text in the running footer area, pressing Shift+Enter at the end of each line:
	6. Click at the beginning of the first line of the footer text, and then choose InsertÆHorizontal Line.
	7. Double-click the horizontal line.
	8. In the Horizontal Line dialog box, do the following:
	a. Set the Width to 100%.
	b. Set the Height to 1px.
	c. Select Custom, and then set the Fill color to Navy.
	d. Click OK.
	9. Select and delete the placeholder text from the body area of the template.
	10. Click the Save All toolbar button.


	Lab 15.3 Apply the Topic Template to Existing Topics
	1. Open the Topics List and display all topics.
	2. Select all topics in the Topic List except the external URL listed at the bottom.
	3. Right-click the selected topics, and then choose Properties from the right-click menu.
	4. On the General tab in the Topic Properties dialog box, choose Solitaire Template from the Template list, and then click OK.
	5. Generate your Help system and check the results.

	Lab 15.4 Remove the Template from Glossary Term Topics
	1. In the Topics List, choose the Glossary folder from the drop-down list at the top.
	2. Select all the glossary topics except “Solitaire Glossary.”
	3. Right-click the selected topics, and then choose Properties from the right-click menu.
	4. On the General tab in the Topic Properties dialog box, choose None from the Template list, and then click OK.
	5. Generate your Help system and check the results.

	Lab 15.5 Create a New Topic Based on the Topic Template
	1. In the Project Manager, right-click the Overviews folder, and then choose New Topic from the right-click menu.
	2. In the New Topic dialog box, type Legal Notices as the topic name.
	3. Click OK.
	4. As the topic text, type:


	Lab 15.6 Modify the Topic Template
	1. In the Project Manager, double-click Solitaire Template.htt in the Templates folder.
	2. Double-click the running footer area to open the footer for editing. If the Horizontal Rule dialog box appears, dismiss it without making any changes.
	3. Click after the space that follows the word Copyright.
	4. Choose InsertÆSymbol.
	5. In the Symbol dialog box, do the following:
	a. Select the © symbol.
	b. Click Insert.
	c. Click Close.
	6. Press the space bar to separate the © symbol from the year.
	7. Click the Save All toolbar button.
	8. Generate your Help system and check the results.



	Lab 15.7 Create a Topic Template with Body Text
	1. Create a new topic template and name it Procedure Template.
	2. Add the same running headers and footers to the Procedure Template that you added to the main Solitaire Template.
	3. Edit the placeholder text in the topic template until it looks like this:

	4. Click the Save All toolbar button.
	5. In the Project Manager, create a new topic in the Procedures folder, and base it on the Procedure Template. As the topic title, type Un-installing Solitaire.
	6. Edit the topic content until the topic looks like this:
	7. Right-click in the WYSIWIYG Editor, and then choose Topic Properties from the right-click menu.
	8. In the Topic Properties dialog box, change the topic title from Un-installing Solitaire to Uninstalling Solitaire.
	9. Generate your Help system and check the results.


	Unit Summary
	. A topic template can specify default running headers and footers, as well as body text.
	Unit 16 Adding a Glossary Tab

	Unit Overview
	In this unit, you will learn how to:


	What Is a Glossary Tab?
	Using RoboHelp, you can add a Glossary tab to the navigation pane in an HTML Help or WebHelp Help system. The Glossary tab is not a standard component of Microsoft HTML Help; it is an add-on provided by RoboHelp.
	Figure 16.1 The Glossary Tab in an HTML Help System

	Up to this point in the course, you have created glossary definitions as standard Help topics, and included popup hyperlinks whenever the terms appear within a topic. This is a perfectly reasonable way to provide an online glossary.
	Benefits of RoboHelp’s Glossary Tab
	. The Glossary tab is integrated into the navigation pane in the running Help system, thereby giving the online glossary a more prominent place in your Help system.


	Limitations of RoboHelp’s Glossary Tab
	. Definitions in the Glossary tab are limited to a single paragraph and cannot include images or character formatting such as bold or italics.

	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	The Glossary Designer
	The Glossary Designer enables you to create the glossary terms and definitions that will be displayed in the Glossary tab in your Help system.
	Figure 16.2 The Glossary Designer


	Glossary Hotspot Wizard
	If you add a Glossary tab to your Help system, you can use the Glossary Hotspot Wizard to add expanding hotspots to your Help to...
	Figure 16.3 Expanding Hotspot in Topic Text

	The Glossary Hotspot Wizard consists of two separate pages, the first of which is shown in Figure 16.4.
	Figure 16.4 Glossary Hotspot Wizard (First Page)




	Lab 16.1 Add Glossary Terms and Definitions
	1. Click the Glossary tab to open the Glossary Designer.
	2. In the Term box, at the top of the Glossary Designer, type deck stack, and then press Enter or click the Add button.

	3. In the Definition for box, type the following text:
	4. Add definitions for the other four glossary terms: row stack, Standard scoring, suit stack, and Vegas scoring.


	Lab 16.2 Enable the Glossary Tab in Your Project
	1. In the Project Manager, double-click solitaire in the Windows folder.
	2. In the Window Properties dialog box, select Glossary under Tri- pane Tabs and Windows, and then click OK.
	3. Generate your Help system and check the results.
	4. Close the Help system.

	Remove Glossary Topics from Your Project
	5. In the Topics List, select all the glossary topics, including the “Solitaire Glossary” topic.
	6. Right-click the selected topics, and then choose Delete from the right-click menu.
	7. Click Yes to confirm that you want to delete the topics.
	8. Click Yes to All.
	9. Open the “Scoring Information” topic in the WYSIWYG Editor.


	Lab 16.3 Add Expanding Hotspots for Glossary Terms
	1. Choose ToolsÆGlossary Hotspot Wizard.
	2. Select Automatically add definitions for all topics, and then click Finish.
	3. Click Close.
	4. Generate your Help system, navigate to the “Solitaire Window” topic, and click the deck stack hyperlink.
	5. Click the deck stack hyperlink again to collapse the definition.
	6. Close the Help System.
	7. Open the “Solitaire Window” topic in the WYSIWYG Editor.
	8. Select the suit stacks text.
	9. Click the Glossary tab.
	10. Drag the suit stack term from the Glossary tab and drop it over the selected text in the WYSIWYG Editor.
	11. Repeat Steps 8-10 to create an expanding hotspot for the row stacks text.
	12. Generate your Help system, navigate to the “Solitaire Window” topic, and check the results.
	Unit Summary
	. You can add a Glossary tab to the navigation pane in a Help system in either HTML Help or WebHelp format.
	Unit 17 Adding Browse Sequences

	Unit Overview
	In this unit, you will learn how to add browse sequences to give your users better linear access to topics.


	What Are Browse Sequences?
	A browse sequence is a series of topics, typically related to a single broad, subject area, that you arrange in order so that users can easily read them sequentially.
	Figure 17.1 Browse Sequences in RoboHelp’s Online Help

	The browse sequence area includes a number of navigational controls, as shown in Figure 17.2.
	Figure 17.2 Browse Sequence Navigational Controls


	RoboHelp Components in this Unit
	This unit introduces the Browse Sequence Editor, the tool you use to create and edit browse sequences in a Help project.
	Figure 17.3 The Browse Sequence Editor



	Lab 17.1 Add Browse Sequences
	1. Choose ToolsÆBrowse Sequence Editor.
	2. In the Browse Sequence Editor, click Auto-create using TOC.
	3. Click OK.
	4. Use the plus signs to expand all three entries under Browse Sequences, as shown in the following illustration:
	5. In the Browse Sequence Editor, click the Untitled browse sequence, and then click Remove.
	6. Click Yes to confirm the deletion, and then click OK.
	7. Generate your Help system and check the results.
	Unit Summary
	. Browse sequences provide an additional navigational tool for users of a Help system, making it easy to browse through collections of related topics in a linear sequence defined by the Help author.
	Unit 18 Using DHTML Effects

	Unit Overview
	In this unit, you will learn how to:


	What Are DHTML Effects?
	DHTML stands for Dynamic HTML and refers to the combination of HTML code, CSS styles, and the JavaScript scripting language. By ...
	. Drop-down hotspots

	How DHTML Effects Work
	DHTML effects are triggered by an event. Expanding hotspots are associated with an event named “on click.” When a user clicks the hotspot, it expands.
	. “During mouse rollover,” which causes the effect to occur when the user rolls the mouse pointer over text or an image.


	When to Use DHTML Effects
	Used judiciously, drop-down hotspots and, to a lesser extent, expanding hotspots can be useful in a Help project. They can support the valid Help design goal of progressively disclosing information in a topic.


	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	DHTML Effects Dialog Box
	You use the DHTML Effects dialog box to define animations and other visual effects for text and images in a Help system.
	Figure 18.1 DHTML Effects Dialog Box


	The Drop-down Hotspot Editor
	You use the drop-down hotspot editor to create the content for a drop- down hotspot. The editor is displayed as a popup window in the WYSIWYG Editor, as shown in Figure 18.2.
	Figure 18.2 The Drop-down Hotspot Editor




	Lab 18.1 Create Animation with DHTML Effects
	1. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	2. Select the topic title text, and then choose DHTMLÆInsert/Edit Dynamic HTML Effects.
	3. In the DHTML Effects dialog box, do the following:
	a. Under When, select Page has been loaded.
	b. Under What, select Fly in.
	c. Click OK.
	4. Click the View Selected Item toolbar button to preview the effect.
	5. Close the preview window.
	6. Select the first paragraph of text in the topic, and then choose DHTMLÆInsert/Edit Dynamic HTML Effects.
	7. In the HTML Effects dialog box, do the following:
	a. Under When, select Page has been loaded.
	b. Under What, select Rock and Roll.
	c. Under Settings, set the Duration to Long.
	d. Click OK.
	8. Click the View Selected Item toolbar button to preview the effect.
	9. Close the preview window.


	Lab 18.2 Remove DHTML Effects
	1. In the “Welcome to Solitaire” topic, click within the first text paragraph.
	2. Choose DHTMLÆRemove Dynamic HTML Effects.
	3. Click the View Selected Item toolbar button to preview the effect.


	Lab 18.3 Create Drop-down Hotspots
	1. Open the “Starting a New Game” topic in the WYSIWYG Editor.
	2. Select the line of text that reads:
	3. Choose EditÆCut or press Ctrl+X.
	4. Select the line of text that reads:
	5. Choose DHTMLÆCreate Drop-down Hotspot and Text.
	6. In the Drop-down Text Editor, select the placeholder text, and then chose EditÆPaste or press Ctrl+V.
	7. Click anywhere in your topic outside the Drop-down Text Editor.
	8. Select the line of text that reads:
	9. Choose EditÆCut or press Ctrl+X.
	10. Select the line of text that reads:
	11. Choose DHTMLÆCreate Drop-down Hotspot and Text.
	12. In the Drop-down Text Editor, select the placeholder text, and then choose EditÆPaste or press Ctrl+V.
	13. Click anywhere in your topic outside the popup window.
	14. Generate your Help system, navigate to the “Starting a New Game” topic, and check the results.

	Unit Summary
	. DHTML stands for Dynamic HTML and refers to the combination of HTML code, CSS styles, and JavaScript.
	Unit 19 Including Multimedia

	Unit Overview
	In this unit, you will learn how to add multimedia objects to Help topics.


	Which Multimedia Formats Are Supported?
	If you use multimedia in a Help system, the following are the formats you are most likely to use:
	. Sound files in .wav, .mp3, .wma, or .mid format


	RoboHelp Components in this Unit
	This unit introduces the Multimedia dialog box, which you use to add multimedia elements to a Help system.
	Figure 19.1 Multimedia Dialog Box



	Lab 19.1 Add Video to a Topic
	1. Create a new topic in the Overviews folder. Use the template named Solitaire Template and name the topic Demonstration.
	2. As the topic text, type:
	3. Click in a blank line beneath the topic text.
	4. Choose InsertÆMultimedia.
	5. Click the Browse button.
	6. Navigate to and select the RoboDemo_Sample.swf file from your course diskette.
	7. In the TOC Composer, add the “Demonstration” topic to the “About Solitaire” book.
	8. Generate your Help system and navigate to the Demonstration topic.

	Lab 19.2 Add Sound to a Topic
	1. In the Topics List, right-click the “Celebrate” topic, and then choose Properties from the right-click menu.
	2. In the Topic Properties dialog box, click the Appearance tab.
	3. Click the Browse button under Background Sound.
	4. Navigate to and select the lovin1.wav file from the course diskette.
	5. Click OK.
	6. In the Topic Properties dialog box, set the Sound Loop Count to 1.
	7. Click OK.
	8. Generate your Help system and, in the Welcome to Solitaire topic, click the box labeled “Have a glass of champagne” in the flowchart graphic.

	Unit Summary
	. You can include sound and video files in many popular formats.
	Unit 20 Independent Review

	Unit Overview
	In this unit, you can practice the skills you have learned so far through an extended, independent, hands-on lab.


	Instructions
	As you work your way through this lab, please place a check mark in the check box as you complete each step. This makes it easier for the instructor to monitor the group’s progress during this lab.


	Lab 20.1 Review What You’ve Learned So Far
	Unit Summary
	. Completing this unit successfully demonstrates that you have gained competency with the most important authoring features in RoboHelp X3. Congratulations!
	Unit 21 Creating Context-sensitive Help

	Unit Overview
	In this unit, you will get an overview of context-sensitive Help and learn how to:
	. Import a developer-supplied map file into a RoboHelp project



	What Is Context-sensitive Help?
	Context-sensitive Help is a technique for selecting and displaying a particular Help topic based on the user’s context within an...
	. Identify the contexts within an application for which you want to provide context-sensitive Help
	. Window-level Context-sensitive Help

	Window-level Context-sensitive Help
	When you provide window-level context-sensitive Help, you create a Help topic for each dialog box, window, pane, or other work area in an application. Typically, users access window-level Help by clicking a Help button or by pressing the F1 key.
	Figure 21.1 Window-level Context-sensitive Help Topic

	What’s This? Help
	What’s This? Help was introduced with Microsoft Windows 95 as a technique for providing information about the individual control...
	Figure 21.2 What’s This? Help Topic




	Working with Map IDs and Map Files
	When a user requests Help, the application needs to determine which context-sensitive Help topic to display. The application use...
	. The main Solitaire window

	Context-sensitive Help Workflow
	Here are the overall steps you must take in order to create context- sensitive Help for an application:
	1. Discuss with your application’s developers:
	- Will the application support context-sensitive Help?
	2. Write a context-sensitive Help topic for each identified context.
	3. If the developers are providing the map file:

	- Import the developer’s map file into your RoboHelp project.
	4. If you are to provide the map file:

	- Auto-generate the map file.
	5. Optionally, create a custom window definition for context- sensitive Help topics.
	6. Generate your Help system and test the context-sensitive Help with a working copy of the application.
	7. Provide your application developers with a copy of the .chm file for your Help system. If you created a custom window definit...




	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. Edit Map IDs Dialog Box

	Edit Map IDs Dialog Box
	You use the Edit Map IDs dialog box to associate the map IDs defined in a map file with topics in your Help project. Once you have associated map IDs with Help topics, your application can call the Help topics using the HTML Help API or WebHelp API.
	Figure 21.3 Edit Map IDs Dialog Box


	Context-sensitive Help Test Tool
	You use the Context-sensitive Help Test Tool to test map IDs in a map file against a compiled HTML Help system to verify that they work correctly.
	Figure 21.4 Context-sensitive Help Test Tool


	BugHunter
	You use BugHunter to “listen in” on the dialog between an application and a Help system and determine which topic an application...
	Figure 21.5 BugHunter




	Lab 21.1 Use a Developer-supplied Map File
	Import the Map File into Your Project
	1. Choose FileÆImportÆMap File.
	2. Navigate to and select the sol.h file on the course diskette.

	Assign Map IDs to Help Topics
	3. In the Project Manager, expand the Context-Sensitive Help folder, and then expand the Map Files subfolder.
	4. Double-click All Map IDs.
	5. From the Map File list, select the sol.h map file.

	6. Assign the first map ID as follows:
	a. In the Topic ID list, click IDH_MainWindow to select it.
	b. In the Topic list select, the “Solitaire Window” topic.
	c. Click the Assign button.
	7. Repeat Step 6 to assign the other two map IDs:
	8. Click Close.
	9. Choose ToolsÆReportsÆMap IDs.
	10. Inspect the report, and then click Close.



	Lab 21.2 Define a Window for Context-sensitive Help Topics
	1. In the Project Manager, right-click the Windows folder, and then choose New Window from the right-click menu.
	2. Create a new window definition as follows:
	3. Generate your Help system.


	Lab 21.3 Display a Help Topic in the Custom Window
	1. Click the Tools tab.
	2. In the Tools tab, double-click the CSH Test icon.
	3. Verify that Offline is selected.
	4. Click the Browse button, and then navigate to and select the solitare.chm file in C:\HTMLHELP\solitaire\!SSL!\ Microsoft_HTML_Help.
	5. In the Window box, type sol-csh.
	6. Click the Select Map File button, and then navigate to and select the sol.h file in your Solitaire project directory.
	7. From the Map Number list, select IDH_SelectCardBack (1002).
	8. Click the Show Help button.



	Lab 21.4 Monitor an Application’s Help Calls Using BugHunter
	1. Verify that Output View is selected on the View menu.
	2. In the Output View pane, click the BugHunter tab.
	3. Choose ToolsÆEnable BugHunter.
	4. Open the Browse Sequence Editor.
	5. In the Browse Sequence Editor, click the Help button.
	6. To disable BugHunter, choose ToolsÆEnable BugHunter.
	7. Close the Browse Sequence Editor.
	Unit Summary
	. Context-sensitive Help is a technique for selecting and displaying a particular Help topic based on the user’s context within an application at the time the user requests Help.
	- A map ID consists of a topic ID and a map number.
	Unit 22 Importing FrameMaker Documents


	Unit Overview
	In this lab, you will learn how to:
	. Set up FrameMaker files before importing them into RoboHelp



	Importing from FrameMaker
	RoboHelp X3 offers limited support for importing content from FrameMaker .mif files.
	Limitations When Importing from FrameMaker
	RoboHelp X3 does not work well with FrameMaker. For many projects, time-consuming clean-up work is required after importing Fram...
	. FrameMaker .fm files cannot be imported into RoboHelp. You must first save each file in .mif format. Then, you can import the .mif files.


	Before Importing FrameMaker Documents
	Before importing FrameMaker content, you should take the following steps to prepare your FrameMaker files:
	1. If your FrameMaker documents include conditional content, use the Show/Hide Conditional Text dialog box to show the conditions you want to import and hide the conditions you do not want to import into RoboHelp.
	2. If your FrameMaker documents use cross-reference formats that include page numbers or punctuation that you do not want to import into RoboHelp, you may want to update the cross-reference formats before importing your documents into RoboHelp.
	3. Update your FrameMaker .book file to ensure that any generated lists and indexes are up-to-date. Correct any errors shown in the Book Log.
	4. Save each .fm file in .mif format.



	Sample FrameMaker Documents
	In this unit, you will import a set of FrameMaker documents provided on the course diskette. The following illustrations show a few sample pages from the document you will import, as they are formatted in FrameMaker.
	Figure 22.1 Sample FrameMaker Pages for Import


	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. FrameMaker Import Wizard

	FrameMaker Import Wizard
	Figure 22.2 FrameMaker Import Wizard (First Page)

	Import FrameMaker - Options Dialog Box
	Figure 22.3 Import FrameMaker - Options Dialog Box



	Lab 22.1 Import FrameMaker .mif Files into a New Help Project
	1. Close the Solitaire Help project by choosing FileÆClose Project.
	2. In RoboHelp, choose FileÆNewProject.
	3. In the New Project dialog box, click the Import tab and select FrameMaker Document (.mif).
	4. Click OK.
	5. Click the Browse button, navigate to the MIF For RoboHelp directory on the course diskette, select all the .mif files, and then click OK.

	6. In the FrameMaker import wizard, click Next.
	7. Complete the second page of the FrameMaker import wizard as shown in the following illustration:
	8. Click Finish.
	9. Click Yes.
	10. Click OK.
	11. In the Project Manager, expand the Single Source Layouts folder, right-click Microsoft HTML Help, and then choose Set as primary layout from the right-click menu.
	12. Generate your Help system and inspect the results.
	13. Close the Help system, and close the solitaire-fm project in RoboHelp.

	Unit Summary
	. RoboHelp provides only limited support for importing content authored in FrameMaker.
	Unit 23 Creating Conditional Content

	Unit Overview
	In this unit, you will learn how to:
	. Create conditional build tags in the Project Manager



	What Is Conditional Content?
	Conditional content is content that is specific to a particular output format, audience, product version, or deliverable.
	What Are Conditional Build Tags?
	To create conditional content in RoboHelp, you use conditional build tags and conditional build tag expressions. Conditional bui...

	What Are Conditional Build Tag Expressions?
	You can apply conditional build tags to entire topics or to text and other elements within topics. After applying conditional bu...
	. Print
	. Help
	. Lite
	. Pro



	RoboHelp Components in this Unit
	This unit introduces the following RoboHelp components:
	. Topic Properties Dialog Box, Advanced Tab

	Topic Properties Dialog Box, Advanced Tab
	You use the Advanced Tab in the Topic Properties dialog box to apply a conditional build tag to an entire topic. By applying a c...
	Figure 23.1 Topic Properties Dialog Box, Advanced Tab


	Define Conditional Build Tag Expression Dialog Box
	You use this dialog box to construct conditional build tags that control which content is included and excluded from the output you generate.
	Figure 23.2 Define Conditional Build Tag Expression Dialog Box




	Lab 23.1 Use Conditional Build Tags within a Topic
	1. In RoboHelp, open your Solitaire Help project.
	2. In the Project Manager, expand the Conditional Build Tags folder.
	3. Open the “Welcome to Solitaire” topic in the WYSIWYG Editor.
	4. In the second paragraph, select Help file.
	5. Right-click the selected text, and then choose Apply Conditional Build TagÆOnline from the right-click menu.
	6. Click just after the letter s in the word This.
	7. Press the space bar, and then type User Guide.
	8. Select User Guide, and then apply the Print conditional build tag to the selected text.
	9. Open the “Options Dialog Box” topic.
	10. Right-click the graphic, and then choose Apply Conditional Build TagÆPrint from the right-click menu.
	11. Repeat Step 10 to apply the Print conditional build tag to the graphic in the “Select Card Back Dialog Box” topic.
	12. In the Project Manager, right-click the Print conditional build tag, and then choose Properties from the right-click menu.
	13. Click OK or Cancel to dismiss the dialog box.


	Lab 23.2 Apply Conditional Build Tags at the Topic Level
	1. Create a new topic in the Procedures folder and name it Installation Instructions.
	2. In the “Installation Instructions” topic, type the following topic text:
	3. Add the “Installation Instructions” topic to the TOC right after the “Welcome to Solitaire” topic.
	4. In the Project Manager or the Topics List, right-click the “Installation Instructions” topic, and then choose Properties from the right-click menu.
	5. In the Topic Properties, dialog box, click the Advanced tab.
	6. Under Topic-level Tags, select Print, as shown in the following illustration:
	7. Click OK.
	8. In the Project Manager, right-click the Print build tag, and then choose Properties from the right-click menu.
	9. Click OK or Cancel to dismiss the dialog box.

	Lab 23.3 Generate Using a Conditional Build Tag Expression
	1. Click View Primary Layout to generate and view your Help system.
	2. Inspect the “Welcome to Solitaire” topic.
	3. Inspect the “Options Dialog Box” and “Select Card Back Dialog Box” topics.
	4. Inspect the TOC.
	5. Close the Help system.
	6. In the Project Manager, expand the Single Source Layouts folder.
	7. Right-click the Microsoft HTML Help layout, and then choose Properties from the right-click menu.
	8. In the HTML Help Options dialog box, click the Define button under Conditional Build Tag Expressions.
	9. In the Available tags list, double-click Print to move it to the Exclude from output list.
	10. Click OK, and then click Save.
	11. Generate your Help system, and inspect the TOC, and the “Welcome to Solitaire,” “Options Dialog Box,” and “Select Card Back Dialog Box” topics.

	Unit Summary
	. Conditional content is content that is specific to a particular output format, audience, product, or deliverable.
	Unit 24 Creating WebHelp Output

	Unit Overview
	In this unit, you will learn how to:
	. Select a primary layout for your Help project



	What Are Single Source Layouts?
	A single source layout is a named collection of settings that RoboHelp uses to generate output in a particular format. By default, each RoboHelp project you create includes the following standard single source layouts:
	. WebHelp

	Selecting a Primary Layout
	One of the single source layouts in your project is always the primary layout. You can designate which layout is the primary lay...


	Setting Up the WebHelp Layout
	When you generate WebHelp, you use the WebHelp layout instead of the HTML Help layout. The WebHelp layout offers somewhat different options.
	To set up the WebHelp layout:
	WebHelp General Dialog Box
	You use the WebHelp General Dialog Box dialog box to set general options for your WebHelp output.
	Figure 24.1 WebHelp General Dialog Box
	. Use Lowercase File Names: This option is selected by default and forces RoboHelp to use only lowercase characters in the file ...


	WebHelp Navigation Dialog Box
	WebHelp offers navigation controls similar to, but not exactly the same as, those offered in HTML Help. Figure 24.2 shows the WebHelp navigational controls displayed in a browser window.
	Figure 24.2 Navigation Controls in WebHelp

	You use the WebHelp Navigation Dialog Box dialog box, shown in Figure 24.3, to select which navigational features to include in your WebHelp output.
	Figure 24.3 WebHelp Navigation Dialog Box
	. Select the buttons you want to appear in the toolbar.
	. Browse Sequences: Select this option to include browse sequences in your WebHelp output. WebHelp, unlike Microsoft HTML Help, displays the browse buttons in the navigation pane, as shown in Figure 24.2 on page 184.


	WebHelp Options Dialog Box
	WebHelp can use several different technologies to display the navigation pane in the user’s web browser, including DHTML, a Java...
	Figure 24.4 WebHelp Options Dialog Box
	. DHTML > Java Applet > Pure HTML: Select this option to use Dynamic HTML and Java applets for added functionality in your WebHe...
	. DHTML > Pure HTML: Select this option if you never want to use Java applets for your output and want to use Dynamic HTML for added functionality instead. If an end user’s browser does not support DHTML, pure HTML will be used instead.
	. Only one TOC book at a time can be expanded.


	WebHelp Publish Dialog Box
	When you generate WebHelp, RoboHelp can automatically publish the output to an intranet or Internet web server, a network share,...
	Figure 24.5 WebHelp Publish Dialog Box
	. Check for deleted files: Select this option if you want RoboHelp to check for files that have been deleted from the destination server or directory. Selecting this options slows down the publishing process.

	Lab 24.1 Set the Primary Layout
	1. Click the View Primary Layout toolbar button.
	2. Close the Help system.
	3. In the Project Manager, expand the Single Source Layouts folder.
	4. Right-click the WebHelp layout, and then choose Set as primary layout from the right-click menu.

	5. Click the View Primary Layout toolbar button.
	6. Click Yes.
	7. Close the WebHelp browser window.


	Lab 24.2 Generate the WebHelp Layout
	WebHelp is an output format you can use to deliver browser-based Help that works in various browsers on various platforms. For more information about WebHelp, refer to “About WebHelp” on page 16.
	1. In the Single Source Layouts folder, right-click the WebHelp layout, and then choose Properties from the right-click menu.
	2. In the WebHelp General dialog box, do the following:
	a. Select Use Lowercase File Names.
	b. From the Conditional Build Expression list, choose NOT Print.
	c. Click Next.
	3. Click Next.
	4. Click Next.
	5. Click Save.
	6. Click View Primary Layout to generate and view the WebHelp output.
	7. Inspect the output.
	8. Close your web browser.



	Lab 24.3 Create a Custom Layout
	1. In the Single Source Layouts folder, right-click the WebHelp layout, and then choose Duplicate Layout from the right-click menu.
	2. In the Layout Name box, type My WebHelp Layout.
	3. Click OK.




	Unit Summary
	. A single source layout is a named collection of settings that RoboHelp uses to generate output in a particular format.
	Unit 25 Creating Printed Output

	Unit Overview
	In this unit, you will learn how to:
	. Set up the Printed Documentation single source layout



	Creating Printed Output with RoboHelp
	Using the Printed Documentation layout in the Single Source Layouts folder, you can export much of the content in a Help project to one or more Microsoft Word .doc files.
	. RoboHelp can transfer the styles used in your Help project to the Microsoft Word file it generates. In this case, elements to which you have applied styles in RoboHelp will have the same styles- and the same appearance-in Word.

	How RoboHelp Converts Help Elements
	When you generate printed output from your Help project, RoboHelp excludes the following elements from the generated Word documents:
	. ActiveX controls


	Preparing to Generate Printed Output
	To get the best results from the Printed Documentation layout, it’s best to spend some time preparing before you generate your printed output. Here are some guidelines:
	. Do you want to include all of your Help topics in the printed documents, or only a subset? If you only want to include a subse...
	- Compare the paragraph styles used in your RoboHelp project with the styles defined in your Word template.



	Setting Security Options in Microsoft Word
	To set macro security in Word:
	1. Choose ToolsÆOptions.

	2. On the Security tab in the Options dialog box, click the Macro Security button.
	3. Select Medium or Low, and then click OK.
	4. Click OK to close the Options dialog box.


	Setting Up the Printed Documentation Layout
	When you generate printed output, you use the Printed Documentation layout. The Printed Documentation layouts offers a wide variety of options that determine how RoboHelp converts your Help project to Microsoft Word .doc format.
	To set up the Printed Documentation layout:
	Print Document General
	You use the Print Document General dialog box to set overall conversion options.
	Figure 25.1 Print Document General
	. Name: Type the name you want to use for the printed document-for example, Solitaire User Guide-in the first text box.
	- Generate individual documents to generate an individual .doc file that contains all the content for each top-level book in you...
	- Embed to embed images in the generated .doc file(s). If you embed images, you can exchange the .doc files with other users wit...



	Print Document Content
	You use the Print Document Content dialog box to select the Help topics you want to include in your generated .doc file(s).
	Figure 25.2 Print Document Content

	To move topics between the Topics and Chapter Layout lists:
	To select a view in the Topics list:
	To organize topics in the Chapter Layout list:

	Print Document Appearance
	You use the Print Document Appearance dialog box to specify how you want your Help content to be formatted in Word.
	Figure 25.3 Print Document Appearance (Default)
	. None: Select this option if you want RoboHelp to format your Word document to look as much as possible like the topics in your...
	Figure 25.4 Print Document Appearance (Style Mapping)


	To map project styles to Word styles:




	Lab 25.1 Generate Printed Output
	1. In the Single Source Layouts folder, right-click the Printed Documentation layout, and then choose Properties from the right-click menu.
	2. Type Solitaire User Guide in the first text box.
	3. Select Generate a single document.
	4. Under Images, select Link to documents.
	5. Define a conditional build tag expression suitable for your printed output:
	a. Click the Define button.
	b. Double-click the Online conditional build tag to move it to the Exclude from output list, as shown in the following illustration:
	c. Click OK.
	6. Click Next when the Print Document General dialog box looks like this:
	7. In the Chapter layout list, do the following:

	a. Remove the duplicate “Welcome to Solitaire” page from the “About Solitaire” book.
	b. Remove the duplicate “Playing the Game” page from the “Playing the Game” book.
	c. Remove the “Solitaire Dialog Boxes” page from the “Solitaire Dialog Boxes” book.
	8. In the Topics list, do the following:

	a. Select All Folders from the drop- down list.
	b. Select the “Legal Notices” topic, and then click Add to move it to the Chapter layout list.
	9. If necessary, use the arrow buttons at the top of the Chapter layout list to move the “Legal Notices” topic so that it appears at the top of the list, before the “About Solitaire” book.
	10. Click Next when the Print Document Content dialog box looks like this:
	11. From the Microsoft Word Template list, choose Style Mapping.dot.
	12. In the Map Non-Heading Styles list, select Bulleted-List in the left column, and then select List Bullet in the right column, as shown in the following illustration:
	13. Repeat Step 12 to map other unassigned styles in your project:
	14. Click Save.
	15. In the Single Source Layouts folder, right-click the Printed Documentation layout, and then choose Generate from the right-click menu.
	16. Click Finish.
	17. In the Result dialog box, click View Result.
	18. Review the results.

	Unit Summary
	. RoboHelp can generate Microsoft Word documents containing much of the content of your Help system.
	Unit 26 Distributing Your Help System

	Unit Overview

	Which Files Do You Need to Distribute?
	The files you distribute to end users depend on the Help format you are distributing.
	HTML Help
	You must distribute your project’s .chm file. Unless you chose another location in the Microsoft HTML Help layout, you will find this file in the !SSL!\Microsoft_HTML_Help subdirectory in your Help project directory.
	To register HHActiveX.dll manually:
	1. On the Windows desktop, choose StartÆRun.
	2. In the Run dialog box, type:


	WebHelp
	When you distribute or publish a Help system in WebHelp format, you must include all of the files in the !SSL!\WebHelp subdirectory in your Help project directory.


	Final Build Checklist
	Lab 26.1 Generate Multiple Layouts as a Batch
	1. In the Project Manager, right-click the Single Source Layouts folder, and then choose Batch Generate from the right-click menu.
	2. Select the HTML Help, WebHelp, and Printed Documentation layouts, as shown in the following illustration.
	3. Click Generate.
	4. When RoboHelp finishes generating the layouts, click Close to dismiss the Batch Generate dialog box.



	Unit Summary
	. When you distribute an HTML Help system, you distribute the .chm file. If your Help system includes a Glossary tab or browse sequences or uses the WebSearch feature, you must also distribute-and register-the HHActiveX.dll file.

	Appendix A Additional Resources
	Books
	There are no third-party books about RoboHelp X3 that we can recommend. There are a number of books, however, that may be of interest to new RoboHelp users.
	. HTML & XHTML: The Definitive Guide, Chuck Musciano and Bill Kennedy, O'Reilly & Associates, ISBN: 0-5960-0382-X.


	Conferences
	An annual conference specific to Help authoring is sponsored by WritersUA (formerly WinWriters). WinWriters is a first-rate conf...

	Online Forums
	Online forums include mailing lists, usenet newsgroups, and web- based forums. Many vendors sponsor online forums, and several independent forums are useful, as well.
	eHelp Help Communities
	Address: http://www.helpcommunity.ehelp.com
	. The RoboHelp Knowledge Base offers articles covering known defects, workarounds, and tips and tricks.


	Microsoft Help Authoring Newsgroups
	Microsoft maintains two public usenet newsgroups of interesting to Help authors. The groups are hosted on Microsoft’s public news server at news.microsoft.com.
	. Addresses: microsoft.public.helpauthoring


	Adobe User-to-User Forums
	Address: http://www.adobe.com/support/forums/main.html

	HATT Group
	Address: http://groups.yahoo.com/group/hatt

	TECHWR-L
	Address: http://www.raycomm.com/techwhirl/index.php3

	Framers List
	Address: http://www.frameusers.com


	Other Useful Web Resources
	The following web sites provide information useful to Help authors:
	. Microsoft: Microsoft maintains a set of MSDN pages related to the HTML Help technology.
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	Course Evaluation
	Your comments and feedback are important to us in our effort to monitor and continuously improve the quality of our training cou...
	1. To what extent did this course meet your needs?
	2. How do you rate the instructor’s knowledge of the material?
	3. How do you rate the course materials?
	4. Would you recommend this course to others?
	5. Which parts of the course were most valuable to you?
	6. Which parts of the course were least valuable to you?
	7. Do you have any suggestions for improving the printed course materials?
	8. Are there any other comments or suggestions you’d like to share with us?








